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End-User License Agreement

You have acquired a device ("DEVICE") that includes software licensed by EXFO Inc. (EXFO) from an affiliate of Microsoft
Corporation ("MS"). Those installed software products of MS origin, as well as associated media, printed materials, and
"online" or electronic documentation ("SOFTWARE") are protected by international intellectual property laws and treaties.
Manufacturer, MS and its suppliers (including Microsoft Corporation) own the title, copyright, and other intellectual property
rights in the SOFTWARE. The SOFTWARE is licensed, not sold. All rights reserved.

This EULA is valid and grants the end-user rights ONLY if the SOFTWARE is genuine and a genuine Certificate of Authenticity
for the SOFTWARE is included. For more information on identifying whether your software is genuine, please see
http://www.microsoft.com/piracy/howtotell.

IF YOU DO NOT AGREE TO THIS END USER LICENSE AGREEMENT ("EULA"), DO NOT USE THE DEVICE OR COPY THE
SOFTWARE. INSTEAD, PROMPTLY CONTACT EXFO FOR INSTRUCTIONS ON RETURN OF THE UNUSED DEVICE(S) FOR A
REFUND. ANY USE OF THE SOFTWARE, INCLUDING BUT NOT LIMITED TO USE ON THE DEVICE, WILL CONSTITUTE
YOUR AGREEMENT TO THIS EULA (OR RATIFICATION OF ANY PREVIOUS CONSENT).

GRANT OF SOFTWARE LICENSE. This EULA grants you the following license:
» You may use the SOFTWARE only on the DEVICE.

» Restricted Functionality. You are licensed to use the SOFTWARE to provide only the limited functionality (specific tasks
or processes) for which the DEVICE has been designed and marketed by EXFO. This license specifically prohibits any
other use of the software programs or functions, or inclusion of additional software programs or functions that do not
directly support the limited functionality on the DEVICE. Notwithstanding the foregoing, you may install or enable on a
DEVICE, systems utilities, resource management or similar software solely for the purpose of administration,
performance enhancement and/or preventive maintenance of the DEVICE.

» If you use the DEVICE to access or utilize the services or functionality of Microsoft Windows Server products (such as
Microsoft Windows Server 2003), or use the DEVICE to permit workstation or computing devices to access or utilize the
services or functionality of Microsoft Windows Server products, you may be required to obtain a Client Access License for
the DEVICE and/or each such workstation or computing device. Please refer to the end user license agreement for your
Microsoft Windows Server product for additional information.

» NOT FAULT TOLERANT. THE SOFTWARE IS NOT FAULT TOLERANT. EXFO HAS INDEPENDENTLY DETERMINED HOW TO
USE THE SOFTWARE IN THE DEVICE, AND MS HAS RELIED UPON EXFO TO CONDUCT SUFFICIENT TESTING TO
DETERMINE THAT THE SOFTWARE IS SUITABLE FOR SUCH USE.

» NO WARRANTIES FOR THE SOFTWARE. THE SOFTWARE is provided "AS IS" and with all faults. THE ENTIRE RISK AS TO
SATISFACTORY QUALITY, PERFORMANCE, ACCURACY, AND EFFORT (INCLUDING LACK OF NEGLIGENCE) IS WITH YOU.
ALSO, THERE IS NO WARRANTY AGAINST INTERFERENCE WITH YOUR ENJOYMENT OF THE SOFTWARE OR AGAINST
INFRINGEMENT. IF YOU HAVE RECEIVED ANY WARRANTIES REGARDING THE DEVICE OR THE SOFTWARE, THOSE
WARRANTIES DO NOT ORIGINATE FROM, AND ARE NOT BINDING ON, MS.

» No Liability for Certain Damages. EXCEPT AS PROHIBITED BY LAW, MS SHALL HAVE NO LIABILITY FOR ANY
INDIRECT, SPECIAL, CONSEQUENTIAL OR INCIDENTAL DAMAGES ARISING FROM OR IN CONNECTION WITH THE
USE OR PERFORMANCE OF THE SOFTWARE. THIS LIMITATION SHALL APPLY EVEN IF ANY REMEDY FAILS OF ITS
ESSENTIAL PURPOSE. IN NO EVENT SHALL MS BE LIABLE FOR ANY AMOUNT IN EXCESS OF U.S. TWO HUNDRED
FIFTY DOLLARS (U.S.$250.00).

» Restricted Uses. The SOFTWARE is not designed or intended for use or resale in hazardous environments requiring
fail-safe performance, such as in the operation of nuclear facilities, aircraft navigation or communication systems, air
traffic control, or other devices or systems in which a malfunction of the SOFTWARE would result in foreseeable risk of
injury or death to the operator of the device or system, or to others.

>» Limitations on Reverse Engineering, Decompilation, and Disassembly. You may not reverse engineer, decompile, or
disassemble the SOFTWARE, except and only to the extent that such activity is expressly permitted by applicable law
notwithstanding this limitation.

» SOFTWARE as a Component of the DEVICE - Transfer. This license may not be shared, transferred to or used
concurrently on different computers. The SOFTWARE is licensed with the DEVICE as a single integrated product and may
only be used with the DEVICE. If the SOFTWARE is not accompanied by a DEVICE, you may not use the SOFTWARE. You
may permanently transfer all of your rights under this EULA only as part of a permanent sale or transfer of the DEVICE,
provided you retain no copies of the SOFTWARE. If the SOFTWARE is an upgrade, any transfer must also include all prior
versions of the SOFTWARE. This transfer must also include the Certificate of Authenticity label. The transfer may not be
an indirect transfer, such as a consignment. Prior to the transfer, the end user receiving the SOFTWARE must agree to all
the EULA terms.

>» Consent to Use of Data. You agree that MS, Microsoft Corporation and their affiliates may collect and use technical
information gathered in any manner as part of product support services related to the SOFTWARE. MS, Microsoft
Corporation and their affiliates may use this information solely to improve their products or to provide customized
services or technologies to you. MS, Microsoft Corporation and their affiliates may disclose this information to others, but
not in a form that personally identifies you.
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Internet Gaming/Update Features. If the SOFTWARE provides, and you choose to utilize, the Internet gaming or update
features within the SOFTWARE, it is necessary to use certain computer system, hardware, and software information to
implement the features. By using these features, you explicitly authorize MS, Microsoft Corporation and/or their
designated agent to use this information solely to improve their products or to provide customized services or
technologies to you. MS or Microsoft Corporation may disclose this information to others, but not in a form that personally
identifies you.

Internet-Based Services Components. The SOFTWARE may contain components that enable and facilitate the use of
certain Internet-based services. You acknowledge and agree that MS, Microsoft Corporation or their affiliates may
automatically check the version of the SOFTWARE and/or its components that you are utilizing and may provide
upgrades or supplements to the SOFTWARE that may be automatically downloaded to your DEVICE. Microsoft
Corporation or their affiliates do not use these features to collect any information that will be used to identify you or
contact you. For more information about these features, please see the privacy statement at
http://go.microsoft.com/fwlink/?Linkld=25243.

Links to Third Party Sites. You may link to third party sites through the use of the SOFTWARE. The third party sites are
not under the control of MS or Microsoft Corporation, and MS or Microsoft are not responsible for the contents of any third
party sites, any links contained in third party sites, or any changes or updates to third party sites. MS or Microsoft
Corporation is not responsible for webcasting or any other form of transmission received from any third party sites. MS or
Microsoft Corporation are providing these links to third party sites to you only as a convenience, and the inclusion of any
link does not imply an endorsement by MS or Microsoft Corporation of the third party site.

Notice Regarding Security. To help protect against breaches of security and malicious software, periodically back up
your data and system information, use security features such as firewalls, and install and use security updates.

No Rental/Commercial Hosting. You may not rent, lease, lend or provide commercial hosting services with the
SOFTWARE to others.

Separation of Components. The SOFTWARE is licensed as a single product. Its component parts may not be separated
for use on more than one computer.

Additional Software/Services. This EULA applies to updates, supplements, add-on components, product support
services, or Internet-based services components ("Supplemental Components"), of the SOFTWARE that you may obtain
from EXFO, MS, Microsoft Corporation or their subsidiaries after the date you obtain your initial copy of the SOFTWARE,
unless you accept updated terms or another agreement governs. If other terms are not provided along with such
Supplemental Components and the Supplemental Components are provided to you by MS, Microsoft Corporation or their
subsidiaries then you will be licensed by such entity under the same terms and conditions of this EULA, except that (i)
MS, Microsoft Corporation or their subsidiaries providing the Supplemental Components will be the licensor with respect
to such Supplemental Components in lieu of the "COMPANY" for the purposes of the EULA, and (ii) TO THE MAXIMUM
EXTENT PERMITTED BY APPLICABLE LAW, THE SUPPLEMENTAL COMPONENTS AND ANY (IF ANY) SUPPORT SERVICES
RELATED TO THE SUPPLEMENTAL COMPONENTS ARE PROVIDED AS IS AND WITH ALL FAULTS. ALL OTHER
DISCLAIMERS, LIMITATION OF DAMAGES, AND SPECIAL PROVISIONS PROVIDED BELOW AND/OR OTHERWISE WITH
THE SOFTWARE SHALL APPLY TO SUCH SUPPLEMENTAL COMPONENTS. MS, Microsoft Corporation or their subsidiaries
reserve the right to discontinue any Internet-based services provided to you or made available to you through the use of
the SOFTWARE.

Recovery Media. If SOFTWARE is provided by EXFO on separate media and labeled "Recovery Media" you may use the
Recovery Media solely to restore or reinstall the SOFTWARE originally installed on the DEVICE.

Backup Copy. You may make one (1) backup copy of the SOFTWARE. You may use this backup copy solely for your
archival purposes and to reinstall the SOFTWARE on the DEVICE. Except as expressly provided in this EULA or by local
law, you may not otherwise make copies of the SOFTWARE, including the printed materials accompanying the
SOFTWARE. You may not loan, rent, lend or otherwise transfer the backup copy to another user.

End User Proof of License. If you acquired the SOFTWARE on a DEVICE, or on a compact disc or other media, a genuine
Microsoft "Proof of License"/Certificate of Authenticity label with a genuine copy of the SOFTWARE identifies a licensed
copy of the SOFTWARE. To be valid, the label must be affixed to the DEVICE, or appear on [COMPANY's] software
packaging. If you receive the label separately other than from EXFO, it is invalid. You should keep the label on the DEVICE
or packaging to prove that you are licensed to use the SOFTWARE.

Product Support. Product support for the SOFTWARE is not provided by MS, Microsoft Corporation, or their affiliates or
subsidiaries. For product support, please refer to EXFO support number provided in the documentation for the DEVICE.
Should you have any questions concerning this EULA, or if you desire to contact EXFO for any other reason, please refer
to the address provided in the documentation for the DEVICE.

Termination. Without prejudice to any other rights, EXFO may terminate this EULA if you fail to comply with the terms
and conditions of this EULA. In such event, you must destroy all copies of the SOFTWARE and all of its component parts.

EXPORT RESTRICTIONS. You acknowledge that SOFTWARE is subject to U.S. and European Union export jurisdiction.
You agree to comply with all applicable international and national laws that apply to the SOFTWARE, including the U.S.
Export Administration Regulations, as well as end-user, end-use and destination restrictions issued by U.S. and other
governments. For additional information see http://www.microsoft.com/exporting/.
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Certification Information

Certification Information

North America Regulatory Statement

This unit was certified by an agency approved in both Canada and the
United States of America. It has been evaluated according to applicable
North American approved standards for product safety for use in Canada
and the United States.

Electronic test and measurement equipment is exempt from FCC part 15,
subpart B compliance in the United States of America and from ICES-003
compliance in Canada. However, EXFO Inc. makes reasonable efforts to
ensure compliance to the applicable standards.

The limits set by these standards are designed to provide reasonable
protection against harmful interference when the equipment is operated in
a commercial environment. This equipment generates, uses, and can
radiate radio frequency energy and, if not installed and used in accordance
with the user guide, may cause harmful interference to radio
communications. Operation of this equipment in a residential area is likely
to cause harmful interference in which case the user will be required to
correct the interference at his own expense.

Modifications not expressly approved by the manufacturer could void the
user's authority to operate the equipment.

viii FTB-1



FTB-1

Certification Information

If you purchased the Wi-Fi and Bluetooth option, your unit comes with an
internal wireless module and antenna for which the following information
applies:

» This equipment has been tested and found to comply with the limits
for a Class A digital device, pursuant to Part 15 of the FCC Rules.
Operation is subject to the following two conditions: (1) This device
may not cause harmful interference, and (2) this device must accept
any interference received, including interference that may cause
undesired operation.

» FCC Radiation Exposure Statement: This equipment complies with
FCC radiation exposure limits set forth for an uncontrolled
environment.

» This device complies with Industry Canada license-exempt RSS
standard(s). Operation is subject to the following two conditions: (1)
this device may not cause interference, and (2) this device must
accept any interference, including interference that may cause
undesired operation of the device.

CSA Information

This unit is certified by the CSA (certificate number 162451) and was
evaluated according to applicable CSA standards (as confirmed by cCSAus
mark) as well as applicable IEC standards for use in Canada, the United
States, and other countries.

European Community Declaration of Conformity

An electronic version of the declaration of conformity for your product is
available on our website at www.exfo.com. Refer to the product’s page on
the Web site for details.
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Introducing the FTB-1

The FTB-1 platform is a modular platform, optimized for network
infrastructure construction and troubleshooting via its dedicated FTTH and
Ethernet test applications.

Note: In this documentation, the words “tap” and “double-tap” (related to the
use of a touchscreen) replace the words “click” and “double-click”.

Main Features

Your FTB-1 platform includes the following:
» Multitasking possibilities

» Seven-inch color touchscreen (LCD and touchscreen optimized for
outdoor use available as an option)

Optional built-in power meter and VFL
Optional internal Wi-Fi and Bluetooth devices
Two USB 2.0 ports (host)

Ethernet port (10/100/1000 Base-T)

YYVYVYY

Headset/microphone port (for any commercially available headset
equipped with a microphone, and having a 2.5 mm connector)

\/

Fiber inspection probe port

Optional GPS USB key

\/

» Optional 3G USB modem key



Introducing the FTB-1

Main Features
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Front

Touchscreen

Windows Embedded Standard operating system

VPN capability

Remote access to your unit (via TightVNC or Remote Desktop)
Direct Web access from your unit

Possibility to take screen captures

PDF file generator and viewer available from your unit

Easy transfer of files and folders to a USB storage device

Easy updates for applications via Update Manager

Keypad

including standard
buttons and
alphanumeric keys

—Battery LED

Function bu'ctonsJ ——On/Off button/Power LED
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Introducing the FTB-1

Main Features

— AC adapter/charger
connector
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Module
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vl

Built-in power meter
(optional)

VFL (optional);

laser radiation emitted at this port
when VFL is on

Stylus

Internal Wi-Fi/Bluetooth devices
(optional; sticker indicates that
devices are present)

FTB-1

T

Fiber inspection probe port

Headset/microphone port
(for 2.5 mm connector)

RJ-45 port

USB host ports
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Main Features

Back

Module

Support Support

Battery compartment
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Introducing the FTB-1
LED Indicators Description

LED Indicators Description

There are two LED indicators located on the front panel of your unit,
providing you with information about the power and battery statuses.

LED

Status

Green

Unit is on.

Green, blinking

Unit is in Standby mode.

Off

Unit is off or in Hibernation mode.

Green

Battery is fully charged.

Green, blinking

Battery is charging.

Yellow, blinking  |Unit is not powered by AC and battery is low.
Red No battery in the unit or battery error.
Off Unit is off or unit is not powered by AC and battery

level is above the “low-battery threshold”.

FTB-1
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Keypad Description

Keypad Description

In addition to the on-screen keyboard, your unit is equipped with a keypad
which gives you access to various tools at all times.

The keypad comprises arrow keys for navigation (left, right, up, down),
alphanumeric keys (similar to phone keys to enter both numbers and text),
and other hardware buttons.

Note: Not all applications support text entry with the alphanumeric keys.

The table below shows an overview of their purpose.

Button Meaning
N Adjusts screen brightness (5 levels).
7N
» Displays the on-screen keyboard
==-/ g » Takes a screen capture (button held down for a few

seconds)

Enables you to switch from one task to another.

Turns your unit on and off.

For more information on the various ways to turn off your unit,
see Turning On or Off the Unit on page 29.

Starts/stops a test.

FTB-1
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Introducing the FTB-1
Keypad Description

Button

Meaning

Moves to the next group of features.

Confirms last entry; equivalent of the ENTER button.

Deletes the item/character.

K-S

Exits or cancels last entry.
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Power Sources

Power Sources

Your unit operates with the following power sources:

» AC adapter/charger (connected to standard power outlet—indoor use
only). Compatible car outlet adapter available upon request.

» One lithium-ion rechargeable battery (automatically takes over if you
disconnect the AC adapter/charger).

Note: When it is connected with the AC adapter/charger, the unit will function
even if the battery is not present.

» Possible to switch from AC adapter/charger to battery power or
vice versa without affecting operation.

» The battery recharges automatically when the AC adapter/charger
is connected.

» The battery is offered in two formats: four-cell (small) and
eight-cell (large).

» Rechargeable battery (for clock). This battery can keep the date and
time for weeks even if AC power and the lithium-ion battery (main
battery) are not connected.

Optional Software Package

An optional software package (IPT package) is offered with the
application. With this package, you can perform ping and trace route tests.
For more information on how to activate software options, see Activating
Software Options on page 42.

8 FTB-1
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Introducing the FTB-1

Conventions

Conventions

H)

= J =

Before using the product described in this guide, you should understand
the following conventions:

WARNING

Indicates a potentially hazardous situation which, if not avoided,
could result in death or serious injury. Do not proceed unless you
understand and meet the required conditions.

CAUTION

Indicates a potentially hazardous situation which, if not avoided,
may result in minor or moderate injury. Do not proceed unless you
understand and meet the required conditions.

CAUTION

Indicates a potentially hazardous situation which, if not avoided,
may result in component damage. Do not proceed unless you
understand and meet the required conditions.

IMPORTANT

Refers to information about this product you should not overlook.






2 Safety Information
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FTB-1

WARNING

Do not install or terminate fibers while a light source is active.
Never look directly into a live fiber and ensure that your eyes are
protected at all times.

WARNING

The use of controls, adjustments and procedures, namely for
operation and maintenance, other than those specified herein may
result in hazardous radiation exposure or impair the protection
provided by this unit.

When you see the following symbol on your unit

that you refer to the instructions provided in your user
documentation. Ensure that you understand and meet the required
conditions before using your product.

IMPORTANT A
, make sure

IMPORTANT

Other safety instructions relevant for your product are located
throughout this documentation, depending on the action to
perform. Make sure to read them carefully when they apply to your
situation.
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Other Safety Symbols on Your Unit

One or more of the following symbols may also appear on your unit.

Symbol

Meaning

Direct current

Alternating current

Both direct and alternating current

The unit is equipped with an earth (ground) terminal.

The unit is equipped with a protective conductor terminal.

The unit is equipped with a frame or chassis terminal.

On (Power)

O—+®

Off (Power)

FTB-1
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Laser Safety Information

Laser Safety Information

Units with Built-In VFL

Your instrument is a Class 3R laser product in compliance with standards
IEC 60825-1: 2007 and 21 CFR 1040.10, except for deviations pursuant to
Laser Notice No. 50, dated June 24, 2007. Laser radiation is emitted at the
output port. It is potentially harmful in direct intrabeam viewing.

The following label(s) indicate that the product contains a Class 3R source:

¥ H VFL option is available

Complies with 21 CFR

IEC 60825-1:2007
21 CFR 104010 1040.10 and 1040.11

VISIBLE LASER RADIATION oxcoptfor doviations

AVOID DIRECT EYE EXPOSURE pursuant to Laser
CLASS 3R LASER PRODUCT Notice No.50 dated
1650 £10 nm 2007.
Pgut maximum < 5mW (into free space)
— 1061384

|
Affixed to bottom panel of unit.

The VFL laser is active when the *3 symbol is displayed in the power
meter and VFL application.

Units without Built-In VFL

If your unit is not equipped with a VFL, the laser class of your unit depends
on the modules that you use. Refer to the user guide or the online help of
the different modules for the exact information.
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Safety Information

Electrical Safety Information

Electrical Safety Information

14

If you need to ensure that the unit is completely turned off, disconnect the
power cable and remove the battery.

yVvyYYy

\/

WARNING

Use the external power supply indoors only.
Position the unit so that the air can circulate freely around it.

Operation of any electrical instrument around flammable gases
or fumes constitutes a major safety hazard.

To avoid electrical shock, do not operate the unit if any part of
the outer surface (covers, panels, etc.) is damaged.

Only authorized personnel should carry out adjustments,
maintenance or repair of opened units under voltage. A person
qualified in first aid must also be present. Do not replace any
components while power cable and battery are connected.

Unless otherwise specified, all interfaces are intended for
connection to Safety Extra Low Voltage (SELV) circuits only.

Capacitors inside the unit may be charged even if the unit has
been disconnected from its electrical supply.
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Electrical Safety Information

WARNING

» Use only the listed and certified AC adapter/charger provided by
EXFO with your unit. It provides reinforced insulation between
primary and secondary, and is suitably rated for the country
where the unit is sold.

» Use only accessories (such as the car outlet adapter, batteries,
and fiber inspection probe) designed for your unit and
approved by EXFO. For a complete list of accessories available
for your unit, refer to its technical specifications.

» When you use the unit outdoors, ensure that it is protected
from liquids, dust, direct sunlight, precipitation, and full wind
pressure.

15



Safety Information

Electrical Safety Information

Equipment Ratings

Temperature

» Operation » unit powered by battery: 0 °C to 50 °C
(32 °F to 122 °F)

» unit connected to AC adapter: 5 °C to 40 °C
(41 °F to 104 °F)

» Storage

\/

unit without battery: —40 °C to 70 °C
(-40 °F to 158 °F)

unit with battery: —20 °C to 60 °C (-4 °F to 140 °F)
AC adapter: —20 °C to 60 °C (-4 °F to 140 °F)

Relative humidity? unit: <95 % non-condensing

AC adapter: 10 % to 80 % non-condensing

YYVYVvYYy

2000 m (6562 ft) (unit connected to external power
supply)
5000 m (16405 ft) (unit operated from battery)

Maximum operation altitude

\/

Pollution degree 2 (unit connected to external power supply)

\/

3 (unit operated from battelry)b

\/

unit:
AC adapter: II

Overvoltage category

vy

Measurement category Not rated for measurement categories II, III, or IV

Input power® » unit: — 24V;3.75 A
» AC adapter: ~ 100 - 240 V; 50/60 Hz; 1.6 A

a. Measured in 0 °C to 31 °C (32 °F to 87.8 °F) range, decreasing linearly to 50 % at 40 °C (104 °F).

b. Equipment must be normally protected against exposure to direct sunlight, precipitation and full wind
pressure.

c. Not exceeding = 10 % of the nominal voltage.

16 FTB-1



FTB-1

Safety Information

Electrical Safety Information

IMPORTANT

The operation and storage temperatures of some modules may
differ from the temperatures specified for your platform. In this
case, always ensure that you comply with the most restrictive
conditions (either module or platform).
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3 Getting Started with Your Unit

Inserting and Removing Test Modules

CAUTION
Never insert or remove a module while the FTB-1 is turned on. This

will result in immediate and irreparable damage to both the
module and unit.

CAUTION
To avoid damaging your unit, use it only with modules approved by
EXFO.

To insert a module into the FTB-1:
1. Turn off your unit (Shutdown).

2. Position the unit so that its front panel rests on a flat surface such as a
table.

3. Place the module on the platform making sure that the bumpers and
the shorter sides of the module are flush with those of the platform. If
necessary, slightly move the module until alignment is correct.
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Getting Started with Your Unit

Inserting and Removing Test Modules

4. Using a flat screwdriver, turn the screws (4) clockwise until they are
tightened.

This will secure the module into its “seated” position.

Turn screws
clockwise

Back panel

When you turn on the unit, the startup sequence will automatically detect
the module.
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Getting Started with Your Unit

Inserting and Removing Test Modules

To remove a module from the FTB-1:

1.
2.

Turn off your unit (Shutdown).

Position the unit so that its front panel rests on a flat surface such as a
table.

Using a flat screwdriver, turn the screws (4) counterclockwise until
they are loose. Since they are captive screws, you cannot remove them
completely.

Turn screws (</ ﬂ%ﬁ\
DD

counterclockwise —
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Getting Started with Your Unit

Inserting and Removing Test Modules

4. Hold the module by its sides (NOT by the connectors) and pull it up.

CAUTION

a Pulling a module by its connectors could seriously damage both the
module and connector. Always pull a module by its casing.
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Using the Supports

Using the Supports

Your unit has been designed to stand either vertically (with the screen
facing you), or at an angle, using the two supports.

All the modules that you can use with your unit are equipped with two
supports with which you can change the orientation of your unit. Once the
module is inserted in your FTB-1, you can use the supports.

Note: The supports ensure optimum stability to the unit during your tests.

To change the orientation of the unit using the supports:
Pull out the two supports.
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Getting Started with Your Unit

Securing Your Unit Using a Kensington Lock

Securing Your Unit Using a Kensington Lock

All the modules that you can use with your unit are equipped with a
security slot to which you can connect an optional Kensington lock
(security cable). Once the module is inserted in your FTB-1, you can secure
your unit with this lock to help prevent theft.

To secure your unit:

Connect your lock to the security slot located on the side of your module.
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Using a Keyboard, Mouse or Other USB Devices

Using a Keyboard, Mouse or Other USB Devices

Your unit supports many USB devices. The table below lists the supported

USB devices.

Device

Details

Memory key

For data transfer between your unit and a computer
when you do not have access to a network. If you
need information on how to transfer data using a
memory key, see Managing Data on page 121.

Keyboard

When you are required to enter alphanumeric data,
an on-screen (virtual) keyboard is displayed. However,
if you prefer, you can use a hardware keyboard.

Note: Even if a keyboard is connected, the
on-screen keyboard will still be
displayed when you work in Mini
Toolbox.

Mouse

If your prefer to use a mouse instead of the
touchscreen, you can connect one.

Composite device

You can use composite devices, that is devices that
input information to your unit using more than one
mean (for example, combinations of keyboard and
mouse).

Hub

This device will be particularly useful to you if you
need extra USB ports.

USB to RS-232
adapter
(purchased from
EXFO)

To be able to transfer data between your unit and a
device only equipped with RS-232 (serial) ports. For
more information, see Using the USB to RS-232
Adapter on page 136.
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Getting Started with Your Unit
Using a Keyboard, Mouse or Other USB Devices
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Device Details
GPS USB key To be able to know the position of your unit (latitude
(purchased from |and longitude coordinates). For more information,
EXFO) see Retrieving the GPS Location of Your Unit on
page 112.

3G USB modem |To access the Internet without having to connect to a
key (purchased |Wi-Fi or an Ethernet network. For more information,
from EXFO) see Accessing the Internet with a 3G USB Modem Key

on page 106.

You can connect several devices at the same time.

IMPORTANT

Your unit does not support USB printers. If you want to print
documents, you must use PDFCreator or a network printer

(see Printing Documents on page 89), or transfer your files to a
computer (see Managing Data on page 121) that has access to a
network printer.
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Getting Started with Your Unit
Using a Keyboard, Mouse or Other USB Devices

To use a USB device with your unit:

Connect the USB device to any of the USB ports (located on top of the
unit).

Note: It is not necessary to turn off the unit before connecting the USB device. The
software will automatically detect its presence.

Your device is automatically recognized and immediately usable (provided
that it uses the drivers already available on your unit).
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Getting Started with Your Unit
Using the On-Screen (Virtual) Keyboard

Using the On-Screen (Virtual) Keyboard

Your unit is equipped with an on-screen keyboard that supports
multilingual features. This keyboard functions according to the keyboard
settings of Windows.

To use the on-screen keyboard:

1. From the unit's keypad, press the ¥&7%/@ button.

2. Select the location where you want to enter text.
3. Enter the data as required.
4

Exit the location when you have finished entering data.

Right-Clicking with the Touchscreen

If you are used to work with a mouse, you may find it useful to be able to
perform a right-click on your touchscreen.
To right-click with the touchscreen:

From the location where you want to right-click, using the stylus or any
blunt pointing device, press the screen for a few seconds until the shortcut
menu appears.

If you want to hide the shortcut menu without performing any action,
simply tap anywhere outside the menu.
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Turning On or Off the Unit

Turning On or Off the Unit

There are several ways to turn off the unit, including the following:

» Standby: keeps the unit’s status information in memory (RAM). The

next time you turn your unit on, you will quickly return to your work
environment (running applications will still be running).This mode will
take more battery power while the unit is off.

Hibernation: saves the unit’s status information that was in memory
(RAM) to a special file on the disk. The next time you turn your unit on,
this file will be used to ensure that you return to your work
environment (running applications will still be running). The unit will
take longer to start up than in Standby mode, but it requires less battery
power when the unit is off. You can configure your unit to switch
automatically from Standby to Hibernation mode after the specified
delay.

Shutdown: completely cuts power to the test modules and platform;
the unit will perform a complete restart routine the next time you use
it. You should perform a shutdown if you do not intend to use your unit
for a week or more.

After a shutdown, the unit will start in Mini Toolbox or in the application
you defined as the startup application.

Note: Should the unit ever stop responding, you can force a hardware reset by
pressing and holding down the power button for more than 10 seconds.

By default, your unit will display the standard shutdown window from
which you can select the desired shutdown mode. However, you can
configure your unit to perform a different action when the power button is
pressed.

You can also configure your unit to automatically restart when AC power
comes back after the unit has turned off (emergency shutdown, standby,
or hibernation modes) when battery level is too low.

29



Getting Started with Your Unit
Turning On or Off the Unit

To turn on the unit:
Press the On/Off button.

To turn off the unit:

30

1.

2.

Press the On/Off button.
OR
On the Windows taskbar, tap Start.

This will display the standard shutdown window, from which you have

a choice of actions or shutdown modes.

Select Shutdown.

To define the behavior of the power button:

1.
2.

From the Main Menu, tap Setup.

Double-tap Power Options.

# Control Panel

File Edit View Tools Help

o Q ¥ Pseaan [Broes | [F 3 X ©) EH-

Address ‘(} Cantral Panel "‘ 5T

: 3 53 e _1l & ;

9@ = 5 : ST & &=
Administrative Battery Bluetooth  Date and Time Device Folder Options Fonts Internet Java Keyboard

Taols Calibration D Manager Options

D e . 0 2 9w e

) = = = 4
Mouse Network | Power Options | Printersand  Regionaland  Scannersand  Soundsand  User Accounts  Windows
Connection! Faxes Langusge ...  Cameras  Audio Devices Firenal

Power Options Properties

Power Schemes || Alams | Power Meter | Advanced | Hibbnate

'\@ Select the power-saving settings you wank o use.

Dptions
[] Aiways show icon on the taskbar

Prompt for password when computer resumes from standby
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Turning On or Off the Unit

4. From the When I press the power button on my computer list, select

the desired behavior (Ask me what to do option is selected by
default).

Power Options Properties @@
Pawer Schemes | Alarms | Power Meter | Advanced | Hibemate
"L .
“_}; Selact the powsr-saving settings you wart to use.
Optiong

[ &wvays show icon an the taskhar

Prompt for password when computer iesumes from standby

Pawer buttons

When T press the power buttan o fy computer

[ 45k me what to do

5. Tap Apply to confirm the changes, and then OK to return to Control
Panel.
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Turning On or Off the Unit

To configure your unit to automatically restart after AC power
comes back:

1. From the Main Menu, tap System Settings.
2. From the System Settings window, tap Startup Applications.

B2 System Settings
Display and Sound
Backlight
-
v
]
Volume '
-
v
Ren
D Mute ‘ Audio Mixer... H Sound Options... |

3. Select the Power on the unit when AC outlet is connected or after
power outage box to enable the corresponding option.

OR
Clear the box if you prefer that your unit does not restart automatically

after AC power comes back.

B System Settings

Startup Applications

Module application utility applications
Module: FTB-730-23B-EA
| =
Serial number: 540683 E‘ '9‘ il
@) N () A
D : advanced OTDR -~ x| (g Network Stumbler =
rS
A -~
Automatic OTDR Wireshark —
b [ NiiE]
v
Create
v ||
D Ref./Template -
- v
v |
D }L Fault Finder
4 b 4
Fiber inspection probe
When Itap the Probe button Ask me what to do (default value) vl

Automatic povver on
E Power on the unit when AC outlet is connected or after power outage )

4. Tap [ to confirm the changes and return to the main window.
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Installing or Upgrading the Applications

All the necessary applications have been preinstalled and configured at the
factory. However, you may have to upgrade some applications when new
versions become available or to reinstall them.

Note: Only administrator-level users can install software under Windows
Embedded Standard.

From the DVD that came with your unit, you can create an installation USB
key in case you ever need to reinstall Mini ToolBox (the software that
comes with your platform) and the module applications as well as Update
Manager. All the necessary files will be copied to the USB key.

Each time you purchase a new module, you will also receive a DVD with
which you could create a new installation USB key. It could be a good idea
to verify that the most recent Update Manager application is installed on
your unit.

When updates are available for an application, you will need to download
them from Internet, either directly on your unit or on a computer. In the
latter case, you will need to transfer the update files to your unit

(see Managing Data on page 121). The update files must be copied to the
location that has been specified for the deployment packages in Update
Manager.
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IMPORTANT

u If you ever need to reinstall Update Manager on your unit, ensure
that:

» The installation files for Update Manager remain on your unit.
Otherwise, it will not be possible to install new versions of this
application later.

» You choose the folder containing the Update Manager
installation files carefully. If you move or rename this folder, you
will have to manually browse for the modified folder when you
want to install new versions of this application.

For the creation of an installation USB key, you will need:
» the installation DVD

» a computer equipped with a USB port; Windows must be installed on
the computer

» a USB memory key
For the upgrades, you will need:
» an FTB-1 unit

» a computer equipped with a USB port; Windows must be installed on
the computer

» a USB memory key

Note: For the upgrades, the computer and USB key are only necessary if you do
not wish to download the files directly on your unit.

Note: For more information on the installation, refer to the Update Manager
online help.
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To update or reinstall Update Manager:

1.

If necessary, retrieve the desired installation files from the Internet.

If you do not intend to download files directly on your unit, connect a
USB memory key to one of the USB ports of the computer and copy the
installation files to this USB key.

If it is not already done, turn on your unit.
Exit Mini Toolbox and the modules’ applications.

If you want to install Update Manager using the USB key, disconnect it
from the computer and connect it to one of the USB ports of your unit.

On your unit, create a folder on the Windows desktop.

Copy the installation files (from the USB key) to the newly created
folder.

From the newly created folder, tap the Setup.exe file to start the
installation.

Follow the on-screen instructions.

When the installation is complete, simply disconnect the USB memory
key.
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Installing or Upgrading the Applications

To install or upgrade the applications:

1.

36

If necessary, retrieve the desired installation files from the Internet.

If you do not intend to download files directly on your unit, connect a
USB memory key to one of the USB ports of the computer and copy the
installation files to this USB key.

If it is not already done, turn on your unit. If necessary, exit the
modules’ applications.

If you want to install or update applications using the USB key,
disconnect it from the computer and connect it to one of the USB ports
of your unit.

Copy the installation files (from the USB key) to the folder containing
the update and installation packages on your unit. By default, Update
Manager will search for files at the root of the USB key. For more
information, refer to the Update Manager online help.

From Mini ToolBox, on your unit, select the Utilities tab.

Tap Update Manager to start the corresponding application. For more
information on how to install or upgrade applications, refer to the
Update Manager online help.

When installation is complete, simply disconnect the USB memory
key.
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To create an installation USB key:

1. Turn on the computer and insert the installation DVD in the CD/DVD
drive.

Connect a USB memory key to one of the USB ports of the computer.

From the Welcome window on the installation DVD, click Mini
Toolbox and Tools.

Select the Mini Toolbox check box and click Next.

Follow the on-screen instructions. All the necessary components will
be copied to your USB key.

6. When the operation is complete, click Close, and then Exit to close the
installation DVD window.

7. Disconnect the USB memory key from the computer.

Your new installation USB key is now ready.
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Installing Third-Party Applications

Note:

Note:

Only administrator-level users can install software under Windows
Embedded Standard.

By default, your unit is locked to prevent the installation of unwanted
applications and components. However, in some cases, you may need to
install third-party applications such as those allowing you to connect to the
3G/4G network of your Internet services provider.

The Write Filter Manager enables you to unlock your unit to let you install
third-party applications. The lock status of your unit (locked or unlocked) is
displayed in the main window of the Write Filter Manager.

If you intend to work with the standard Sierra Wireless 319U USB key, you
do not need to use the Write Filter Manager. For more information on the
configuration and use of this USB key, see Accessing the Internet with a 3G
USB Modem Key on page 106.

CAUTION
» Installing applications that have not been previously approved

)

38

by EXFO may prevent your unit from working properly.

» To preserve the integrity and stability of your unit, do not forget
to lock it once the installation of the third-party application is
complete.

CAUTION

DO NOT CONNECT any new 3G USB modem key to the unit before
the unit has been unlocked with the Write Filter Manager.

FTB-1



Getting Started with Your Unit
Installing Third-Party Applications

To install third-party applications on your unit:
1. Unlock your unit:

1a. On the Windows taskbar, tap Start, then select All Programs >
EXFO > Write Filter Manager > Write Filter Manager to start the
application.

Note: Ifyou do not see the Write Filter Manager application, see Configuring Your
Unit to Work with the Write Filter Manager on page 40.
1b. Tap the Unlock button. The button label switches to “Lock”.
1c. When the application prompts you to restart the unit, select Yes.
Wait for the startup sequence to complete.

2. Install your third-party application by following the instructions
provided with it.

3. Lock your unit:

3a. On the Windows taskbar, tap Start, then select All Programs >
EXFO > Write Filter Manager > Write Filter Manager to start the
application.

3b. Tap the Lock button. The button label switches to “Unlock”.
3c. When the application prompts you to restart the unit, select Yes.
Wait for the startup sequence to complete.

You are now ready to work with your third-party application.
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Configuring Your Unit to Work with the
Write Filter Manager

Note:

o O

Only administrator-level users can install software under Windows
Embedded Standard.

By default, your unit is locked to prevent the installation of unwanted
applications and components.To install applications that are not part of the
standard EXFO products, you will need to unlock your unit first, using the
Write Filter Manager application.

IMPORTANT

If you want to work with the Write Filter Manager, but the
application is not present on your unit, you must install the most
recent Platform kit first.

To do this, you will need a standard USB memory key and a
computer with an Internet access. You can also retrieve the kit
directly from your unit, but you will need an Internet access (other
than the one that would be provided by the new 3G USB modem
key).

CAUTION

Installing applications that have not been previously approved by
EXFO may prevent your unit from working properly.

CAUTION

DO NOT CONNECT any new 3G USB modem key to the unit before
the configuration is complete and the unit has been unlocked with
the Write Filter Manager.
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To configure your unit to work with the Write Filter Manager:

1. If necessary, turn on your unit.
2. Install the latest Platform kit:

2a. From your computer or your unit, open a Web browser and go to
www.exfo.com.

2b. Log on to your My EXFO account.

2c. Under FTB-1, find the Platform kit. If you need information on
how to download the kit, refer to the Readme file provided with
the kit.

2d. Install the Platform kit on your unit. For more information, refer to
the Readme file provided with the Kit.

Note: At this point, if you have used a USB memory key to transfer the installation
files to your unit, you can rernove it.

You are now ready to work with the Write Filter Manager.
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Activating Software Options

The software options purchased at the same time as your unit have been
activated for you already. However, if you purchase options afterwards, you
will have to activate them yourself.

Before being able to activate options, you need to contact EXFO with the
following information:

>
>

YyYyYvYyYy

Purchase order number of the newly purchased options

Module or platform serial number (depending on whether the software
options were purchased for a module or the platform)

Customer's name
Customer’s company name
Customer’s phone number
Customer’s e-mail address

Module or platform on which the option will be installed

You will receive a single key (key) file with which you will be able to
unlock all the new options that you have purchased.

42
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To activate the options for your unit:

1.
2.
3.
4

Getting Started with Your Unit

Activating Software Options

Connect a USB memory key to one of the USB ports of your computer.

Copy the key file to the USB memory key.

Disconnect the USB key from the computer and connect it to your unit.

From Mini ToolBox, select the Utilities tab, then tap Options

Activation.

T Mini ToolBox

Utilities

FEX

Mini ToolBox @
C

3 Ed

Bluetooth File Calculator EXFO Connect Client FTB-Care
Transfer Wizard

e Ca -
Internet Explorer Options Activation Product
Registration
‘1-1\ . A *
»
< [~ )
TightVHC Server Update Manager USB Data Mover VPH Installer

GPS Coordinates
Viewer

System Info

®

'WiFi Connect

© aff 13/13/2013 12:34PM
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5. In the Platform Options tab, use the Browse button to locate the key

file that you want to use.

% Option Activation E‘

Platform Options | Module Options|

Option activation

Options: Description:

‘Q FPSA Enables you to use the Analyze on capture option
in ConnectorMax.

6. Press Activate.

The option indicator will turn into a green check mark to confirm that
the option is now active.

7. Press OK to close the Option Activation window.

Note: At this point, if you have used a USB key to copy your key file, you can
remove it as it is not required to use your new options.
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Activating Software Options

To activate software options for your module:

1.
2.
3.
4

Connect a USB memory key to one of the USB ports of your computer.

Copy the key file to the USB memory key.

Disconnect the USB key from the computer and connect it to your unit.

From Mini ToolBox, select the Utilities tab, then tap Options

Activation.

T Mini ToolBox

Utilities

FEX

Mini ToolBox @
C

3 Ed

Bluetooth File Calculator EXFO Connect Client FTB-Care
Transfer Wizard

e Ca -
Internet Explorer Options Activation Product
Registration
‘1-1\ . A *
»
< [~ )
TightVHC Server Update Manager USB Data Mover VPH Installer

GPS Coordinates
Viewer

System Info

®

'WiFi Connect

© aff 13/13/2013 12:34PM

45



Getting Started with Your Unit
Activating Software Options

5. Inthe Module Options tab, use the Browse button to locate the key
file that you want to use.

Option Activation g‘
Platform Options | Module Options

Option activation

Modules: Options: Description:
FTB-730-23B-04B-EA 5/N:517897 | | / AD The Auto Diagnostic option
| activates Macrobend and Linear
[SES view functionalities.

6. Press Activate.

The option indicator will turn into a green check mark to confirm that
the option is now active.

Note: You can see the supported options for the module in the Options list.
7. Press OK to close the Option Activation window.

Note: At this point, if you have used a USB key to copy your key file, you can
remouve it as it is not required to use your new options.
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Starting Module Applications
Your modules can be configured and controlled from their dedicated

applications in Mini Toolbox.

To start a module application:

From Mini Toolbox, at the bottom of the window, press the button
corresponding to the desired application.

E_""-"?"“ >
Module inserted in

FTB-730-23B-EA
the platform ‘;J OTOR 1300/1550 nr (549

S/N:540683

System Info

Applications

& 3
specific to—— [al..
the module
Advanced OTDR Automatic OTDR Create Fault Finder LM
Ref./Template
_.ﬂ 11/13/2013 11:57 AM

To start the Power Meter or Probe application:

From Main Menu, press Power Meter or Probe.
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4 Setting Up Your Unit

Adjusting Brightness

FTB-1

Note:

To fit your work environment, you may adjust the LCD brightness. Values
are kept in memory even when you turn the unit off.

These settings do not apply to a fiber inspection probe display.

To adjust the display brightness:
Press the O key repeatedly to switch between brightness levels.
OR

1. From the Main Menu, tap System Settings.

2. If necessary, from System Settings, tap Display & Sound.

B8 System Settings [AEE
Systs
Display and Sound Setﬁ?l'; %

Backlight  Menw
J Display & Sound

3. Move the slider until the screen appearance is to your liking.

B System Seitings

Display and Sound

Backlight
R
Volume
D Mute ‘ Audio Mixer... H Sound Options... |
Touchscreen
Calibration points: |9 vi ‘ Calibrate... ‘ Touchscreen Options...
On-screen keyboard Screen snapshot

On-Screen Keyboard
Screen snapshot optons..|

4. Tap €] to return to the Mini Toolbox window.
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Adjusting Microphone and Speaker Volume

To fit your work environment, you may adjust the microphone and speaker
volume. Values are kept in memory even when you turn the unit off.

To adjust the microphone volume:
1. From the Main Menu, tap System Settings.

2. If necessary, from System Settings, tap Display & Sound.

B System Settings E‘@El

Syst
Display and Sound Setﬁ?l'!'lls g

-
)
' Display & Sound

Backlight

B System Settings

Display and Sound
Backlight

Volume

J

D Mute ‘ Audio Mixer... lH Sound Options... |

4. Select the Voice tab.
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5. Under Voice recording, tap Volume.

Audio Devices Propertie

Volme | Sounds | Audio Voice | Hadware

These seltings cantral volume and advanced aptions far the vaice
playback or recarding device you ssleste

Waice plapback

@ Default device
2

[ V14, HD Audio Duiput v

[ wvoume.. | advanced.. |

Yoice recording
ﬁ Default device
[ V18 HD Audio Input

3|

6. Ensure that the microphone boost option is selected:

6a. From the Options menu, select Advanced Controls.

i Recording Control

(o)

Recording

EE®

Microphane

Balance: Balance:

6b. Tap the Advanced button.

8 Recording Control |ZHE\E‘

Options  Help
Recording Miciophone
Balance: Balance:
Yolume: Yolume:
I ‘—‘—‘
[ Mute all Mute
WIA HD Audio Input
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6c. Under Other Controls, select the 1 Microphone Boost check
box.

Advanced Controls for Microphone §|

FF|  Thesecetngs can e used o make e scuments o you
3 audio.

Tone Controls

These settings control how the tone of wour audio sounds,

Bass:
Treble:

Other Cantrol:

These settings make other changes to how your audio sounds. Ses
vour hardare documentation for detaik.

1 Microphane Bagst

Close

6d. Tap Close.

Note: Normally, you only have to select this option the first time that you adjust
the microphone volume (the option will be selected for all other users as
well). Once it is done, you can control the volume with the slider as
explained at the next step.

7. Under Microphone, use the slider to adjust the sound of your
microphone. Close the window when your settings are complete.

il Recording Control Q|§\E‘

Options  Help
Recording Microphone
Balance: Balance:
Wolume: Wolume:
(-
[ Mute all [ Mute:
V1A HD Audio Input

8. Tap OK to return to the Display & Sound window.
9. Tap €] to return to the Mini Toolbox window.
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To adjust the speaker volume:
1. From the Main Menu, tap System Settings.

2. If necessary, from System Settings, tap Display & Sound.

B System Settings E‘@El
System %]

Display and Sound Settings .

Backlight | Menw
J Display & Sound
| il

Volume

=
£
o
5
=
F
£
m
g
g
£
2
)
2
g
1

] Mute

B System Settings
Display and Sound
Backlight
R
Volume
D Mute ‘ Audio Mixer... ‘ ‘ Sound Options... |
\
Touchscreen
Calibration points: |9 v ‘ Calibrate... H Touchscreen Options... |

Note: You can also select the Mute check box if you want to quickly turn off the
sound.

Note: You can tap the Audio Mixer button if you want to refine the volurne
according to the source of the sound (Master Volume and Wave controls).

4. Tap to return to the Mini Toolbox window.
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54

Recalibrating the Touchscreen

If you notice the touchscreen does not behave in the way it used to
(for example, it is now difficult to select items) it probably needs a

recalibration.

The default calibration method is performed using nine points, but you can
also perform a 4-point, or even a 25-point calibration (linearization) if you

need more accuracy.

You can stop the calibration process at any time, but the touchscreen will
still need calibration. The parameters are taken into account only when the

process is complete.

To recalibrate the touchscreen:
1. From the Main Menu, tap System Settings.

2. If necessary, from System Settings, tap Display & Sound.

B3 System Settings

Display and Sound
Backlight

Volume

J

E] Mute ‘ Audio Mixer... ‘ ‘ Sound Options... |

-
[ Menw
' Display & Sound
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3. From the Calibration points list, select the desired number of points

for the calibration.

B System Settings

Display and Sound

On-screen keyboard

Oon-Screen Keyboard
Options....

Backlight
-
3
e ————
Volume
-
v
D Mute ‘ Audio Mixer... H Sound Options... ‘
Touchscreen
Calibration points: ‘ Calibrate... H Touchscreen Options... ‘

Screen snapshot

sScreen Snapshot Options. ..

4. Tap Calibrate.

|| Mute

Touchscreen

Calibration points:

On-screen keyboard

On-Screen Keyboard
Options...

‘ Audio Mixer... H Sound Options... |
” Calibrate... l| Touchscreen Options... |
N~———o

Screen snapshot

Screen Snapshot Options.. |
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5. Using the stylus (or any blunt pointing device), simply press the center
of the different targets that appear on the screen. Keep pressing until
the application displays OK to indicate that the new parameters have
been taken into account.

9% —Percentage of completion

(S>

OK+——New parameters taken into account

S

Note: If you want to stop the calibration process, press ‘_l from the unit’s
keypad. The application will close automatically and you will return to the
Display & Sound window.

When the calibration is complete, you will return to the Display & Sound
window automatically.

6. Tap [&] to return to the Mini Toolbox window.
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Enabling or Disabling the Touchscreen
Right-Click Feature

By default, you can right-click with your touchscreen (see Right-Clicking
with the Touchscreen on page 28). However, you can disable this feature if

you prefer.
To enable or disable the right-click of the touchscreen:
1. From the Main Menu, tap System Settings.

2. If necessary, from System Settings, tap Display & Sound.

B System Settings E‘E"‘E
" System ]
Display and Sound Settings &
Backlight [Menw ]
J Display & Sound
T Automatic Logol
Volume
D Mute ‘ Audio Mixer... ‘ ‘ Sound Options... |

3. Under Touchscreen, tap the Touchscreen Options button.

B System Settings E“‘sz\

- System B
Display and Sound Settings -
Backlight Menu
J Display & Sound
Automatic Logon
Volume Startup Applications
D Mute | Audio Mixer... H Sound Options... ‘
Touchscreen
Calibration peints: |9 | | Calibrate... I Touchscreen Options...
. S
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4. Select the

I~ Besp On Touch

I Beep On Release

™ Beep From Sound

Linearization Style
" § Points
¥ 25 Points
Doubls Click Time
Shorter<<

Double Click Arsa

Smaller<<

D

Setting tab.

Frequency @';
—_— :
Duretion

[ Beep From System Bezp

Card

== >>Longer

— >>Bigger

Nomal Mode ‘ Option ‘

eGalaxTouch : USB Controller 3

Edge Comp Qardwars | About
General Tools | Display
Bep

|
I

oK Carcel |

5. Tap the Option button.

Double Click Time:
Shorter<<

Double Click Area

Smaller<<

D

[ ——— >sLonger

‘-‘E\gger

Nommal Mode omm
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ok | Cancel

FTB-1



Setting Up Your Unit
Enabling or Disabling the Touchscreen Right-Click Feature

6. From the Option tab, select the Enable Auto Right Click check box to
enable the option.

OR
Clear the check box if you prefer to disable the right-click.

Option @
Option ]

Function

[ Enable Constartt Touch

Jv Enabls Auto Right Click

¥ Enable Touch
J# Enable Cursor Stabilization

Constart Touch Area

6
Smaller ﬂi +:Bigger

Auto Right Click Time
uuuuuu

Shortercs 7J7 »>Longer

0K Cancel | |

7. Tap OKto confirm the changes.
8. Tap OK once again to close the touchscreen parameters window.

9. Tap €] to return to the Mini Toolbox window.
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Customizing the On-Screen Keyboard

You can customize the appearance and behavior of the on-screen
keyboard. For more information on the various parameters that you can
set, refer to the on-screen keyboard online help.

For information on how switch from one of the available languages to
another, see Selecting the Language of Operation on page 72.

To customize the appearance and behavior of the on-screen
keyboard:

1. From the Main Menu, tap System Settings.
2. If necessary, from System Settings, tap Display & Sound.

B System Settings
Display and Sound
Backlight
e Automatic Logon
Volume Startup Applications
D Mute ‘ Audio Mixer... ‘ ‘ Sound Options... |

3. Under On-screen keyboard, tap the On-Screen Keyboard Options

button.
Vv
D Mute ‘ Audio Mixer... ‘ ‘ Sound Options... |
Touchscreen
Calibration points: ‘ Calibrate... ‘ Touchscreen Options... |

On-screen keyboard Screen snapshot

On-Screen Keyboard
( Screen Snapshot Options...|
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4. Configure the keyboard according to your needs.

Fading
Minimize

Desklon locking [ Autostart at Windows startup

& Accessibility
Exceptions
Ward completion
Calculator

[#] keep within monitor area

Animation when opening/dosing

Sounds ——— J
Advance
= Templates Immediate Sl
Startup

Focus change

1de p =
Designer 3'
Tweak
= Licenses
Clients 4

Versions

Note: You can access the online help related to the keyboard options by tapping
the Help button.

5. When you have finished, tap Close.
6. Tap [€] to return to the Mini Toolbox window.
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Enabling or Disabling the Automatic Logon

Note:

Note:

62

Only administrator-level users can enable or disable the automatic logon
feature.

You can configure your unit to automatically log on to Windows at startup
(no need to select a user and enter a password). You can also disable this
feature if you prefer to define separate user accounts with different user
access rights and passwords.

For security reasons, when the unit comes back from standby or hibernate
modes, the application will prompt you to select a user and enter a
password, even if you have enabled the automatic logon feature.

By default, the automatic logon is enabled for the Supervisor user account,
with an empty password. If you want to create (or modify) a password for
the user account for which the automatic logon is enabled, you will have to
disable the feature first, and then enable it again once the new password is
defined.

If you want to modify the account used for the automatic logon, you will
also have to disable the feature first, and then enable it again for the new
account.

To enable (or modify) the automatic logon:
1. From the Main Menu, tap System Settings.

2. From System Settings, tap Automatic Logon.

B System Settings gg|
. System E]
Display and Sound Settings i
Backlight Menu
J Display & Sound
o | Automatic Logon
Volume Startup Applications
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3. Enter the desired user name (account) and the corresponding
password.

B System Settings

Automatic Logon
Automatic logon

Automatically logon to this unit using the following
account parameters:

User name: | My Mews User

Password: e

Note: You must enter information for an existing
user account, as configured in the "User Accounts"

control panel.
Enable Auto Logon

IMPORTANT

You cannot create user accounts or modify passwords from the
Automatic Logon window.

The user name and password that you specify must correspond to
those of an account that has been defined from User Accounts in
Control Panel.

4. Tap Enable Auto Logon.
5. Tap [g] to return to the Mini Toolbox window.

At next startup, you will no longer need to specify a user name and

password (except if the unit comes back from standby or hibernate
modes).
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64

To disable the automatic logon:

From the Main Menu, tap System Settings.

2. From System Settings, tap Automatic Logon.

System Settings
Display and Sound
Backlight
J Display & Sound
R ]
Volume
-
4
D Mute ‘ Audio Mixer... ‘ ‘ Sound Options...

3. Tap Disable Auto Logon.

Automatic Logon

Automatic logon

Automatically logon to this unit using the following
account parameters:

User name: ‘ ‘

Password: ‘ ‘

Note: You must enter information for an existing
user account, as configured in the "User Accounts”
control panel.

Disable Auto Logon

4. When the application prompts you, confirm with Yes.

5. Tap [&] to return to the Mini Toolbox window.

At next startup, you will have to specify the user name and password.
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Selecting the Startup Application

The first time you start your unit, Mini Toolbox is displayed. However, you
can configure your unit to automatically start in any of the available
applications.

The selected application or applications will start automatically the next
time you turn on your unit after a shutdown (not in standby or hibernate
mode). For more information, see Turning On or Off the Unit on page 29.

If you want to configure your unit to start the TightVNC server automatically
at startup (for remote control), see Working With TightVNC on page 164.

If the specified application cannot be started (for example, the required
module is not present in the unit), Mini Toolbox is started automatically.
You will have to select the application again when the module is inserted
into the unit.

To select a startup application:

1. From the Main Menu, tap System Settings.

2. From System Settings, tap Startup Applications.

B System Settings

Display and Sound

Backlight
Display & Sound

Pl sutomatic Logon

. Startup Applicat
Remote Session

Volume

D Mute Audio Mixer... ‘ ‘ Sound Options... |
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3. Under Module application or Utility applications, select the
application or applications you want to start automatically when you
turn on your unit.

System Settings

Startup Applications

Module application Utility applications
Module: FTB-730-23B-EA =
a
Serial number: 540683 E '9‘ 1paiE
= = FS
o Advanced OTDR =] 3 A" network stumbler =
FS
a FS
Automatic OTDR. Wireshark
E ] Ol -
v
Create
I:\ Ref./Template h h 4
To browse W T M
. A Fault Finfer
through the list bk |d - >
T
Fiber inspection probe
‘when I tap the Probe button Ask me whatto do (default value) vl

Automatic power on
\z‘ Power on the unit when AC outlet is connected or after power outage

Note: You can select several utility applications, but only one module application
at a time.

Note: If necessary, you can use the scrolling arrows located at the right of the
Module application and Utility applications lists to browse through the

available items.

Your changes are automatically saved.

4. Tap €] to return to the Mini Toolbox window.
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Selecting the FIP Startup Application

Your unit supports both the fiber inspection probes (FIP) of the FIP-400 and
FIP-400B series. By default, the unit prompts you to select the application
corresponding to the FIP with which you want to work (FIP-400 or

FIP-400B). If you prefer, you can configure the unit to always start your
favorite application directly instead.

To select the FIP startup application:
1. From the Main Menu, tap System Settings.

2. From System Settings, tap Startup Applications.

B3 System Settings

EE
2

System
Display and Sound Settings
Backlight

J Display & Sound

———— LIRS S

J

Volume

E] Mute ‘ Audio Mixer... ‘ ‘ Sound Options... |
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3. From the When I tap the Probe button list, select the desired
behavior. If you want to be prompted each time to confirm the
application to use, select the Ask me what to do option.

Note: If the list is not available, it means that the ConnectorMax2 application is
not installed on your unit. In this case, the ConnectorMax application will
start automatically, enabling you to work with the probes of the FIP-400
series. If you also wish to work with probes of the FIP-400B series, you will
need to install the most recent ConnectorMax Rit.

B System Settings
Startup Applications
Module application Utility applications
Module: FTB-730-23B-EA
| =
Serial number: 540683 @ 'g‘ jRark
= o a
] \E’ Advanced OTDR - x] “Zl’n Network Stumbler =
A
a a
ii| Automatic OTDR Wireshark
bl NlEL |
v
Create
A4 |
D Ref./Template -
- v
v ||
D AA‘L“ Fault Finder
¥ ot
Fiber inspection probe
Wwhen I tap the Probe button Ask me what to do (default value) V|
Automatic power on
\z‘ Power on the unit when AC outlet is connected or after power outage

Your changes are automatically saved.

4. Tap to return to the Mini Toolbox window.
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Configuring Network Printers

To print documents and images on a network printer, you must configure
the printer first.You must know the IP address of the network printer that
you want to configure (contact your network administrator).

IMPORTANT

» Your unit does not support USB printers.

» Your unit only supports network printers compatible with PCL 6
(which is a “Printer Control Language”). If you are not sure

whether a specific printer is compatible or not, contact your
network administrator.

For more information on printing, see Printing Documents on page 89.
To configure the printer:
1. On your unit, from the Main Menu, tap Setup.

2. Double-tap Printers and Faxes.

# Control Panel le
File Edit View Took Hep a‘,'
D - ¥ | Pseaan Folders X ¥ m-
adéress |Gk cantral Panel ¥ B
i - 3 5 : 4 » 4 >
9@ 3= 3 )’D T 7 = = =
Administrative Battery Bluetooth  Date and Time Device Folder Options Fonts Internet Java Keyboard

Tools Calbraton  Devices Manager Options

D@ % )e 2 0 @ e
- = W = b A /4
Mouse Network  Power Optiofs Printersand [Regionaland Scammersand Soundsand  User Accounts

Windows
Connections Faxes  Jlanguage.. Cameras  AudoDevices

Firewal

FTB-1 69



Setting Up Your Unit
Configuring Network Printers

3. Select the HP Universal Printing PCL 6 item.

% Printers and Faxes

File Edt Wiew Toos Help ar
@ Back v () Lﬂ: p Search [0 Folders | x n -
Address |{g Frinters and Faxes 3 ‘ e

4. From the menu, select File > Printing Preferences.

5. Under Find a Printer, select Enter a Printer Address.

HP Universal Printing PCL 6

To view device properties, you must first specify your desired printer.
‘ Selexct the: HP printer you want t use,

Frinters:

[ Recently Used Frinters
= [ Find & Printer
= Enter a Printer

Printer Information:

T, Search for Hetwark PrnEers. .

[, search For Print Shares...

Settings O

6. Enter the IP address of the printer that you want to configure, and then
tap OK.

Enter, a Printer Address...

Enter the network address of the HP printer you want to use.

Printer Address:Q 10.206.50.166
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7. Select the Add this printer to my Printers and Faxes folder check
box.

HP Universal Printing PCL 6

To view device properties, you must first specify your desired printer.
| Select the HP prinker yau wank ko Use,

—==
Printers:
Recently Uszd Printers Frter Infermelion:
= Egl Find a Printer HP Laserlet M5035 MFP (10.206.50.166)
=) (£ Enter & Printer Address... Model: HP Laserlet M5035 MFP

() HP LaserJet M35 MFP (10.206.50.166) Address: 10.205.50.166
G, Search for Netwark Printers. .
[&, search for print Shares...

Check Status...

Wednesday, October 13, 2010 @ 11:45:39 AM

O Processing job from tray 3 I

Settings ( [v Add this prinker t my Printers and Faxes Folder )

8. Tap OK to confirm. The operation can take several minutes to
complete.

9. When the application prompts you, click OK to acknowledge the
message.

10. If desired, modify the printer preferences to your liking.
You can save the whole set of preferences for future use with the

Save As button or press §/ from the unit’s keypad to save the
parameters for the current work session.

11. Close the Printing Preferences window, and then close the Printers
and Faxes window to return to Mini Toolbox.

The printer is now ready to use.

FTB-1 71



Setting Up Your Unit
Selecting the Language of Operation

Selecting the Language of Operation

You may display the user interface in one of the available languages
(default is English).

When you change the interface language, the corresponding keyboard is
not automatically added to the list of available keyboards. You must add
the desired keyboard separately if you want to enter text in a specific
language (both on-screen or “real” keyboards). Once the keyboards are
added, you can switch easily from one input language to another.

IMPORTANT

u The keyboards that you add will not be available from the logon
window.

To avoid problems, when you define or modify passwords, EXFO
recommends that you always use the keyboard corresponding to
the language of the unit at time of purchase. Otherwise, you might
not be able to log on to your user account (unsupported characters,
different keyboard layout, etc.)

Values are kept in memory even when you turn the unit off.

IMPORTANT
The language setting of the VLC media player is independent of the

language setting of Mini Toolbox. You must configure both
separately.
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To select a new interface language:
1. From the Main Menu, tap Setup.

2. Double-tap Regional and Language Options.

# Control Panel
File Edit View Tools Help

Q - | Pt [Froes | [ 3 X ¥) [E-

Address |G Cantrol Panel D>

B = 0 K 9w @B @ &

4

Administrative Battery Bluetooth Date and Time Device Folder Options Fonts Internet Java Keyboard
Taols Calibration Devices Manager Options
H @ % @ 2 0 & e
) =] = 4
Mouse Network Power Options  Printersand  Regional and |Scannersand  Soundsand  User Accounts  Windows
Cameras Audio Devices Firewal

Connections

Regional and Language Options

Fiegional Optics | Langusges | gdvanced

Tex services and input languages
To view or change the languages and methads you can use Lo enter

text, click Details.

Supplemental language suppart
Most languages are installed by defauit. To instal additional languages,
select the appiopriate check box below

Istall s for comple soript and rightoeft languagss (including
Thai)

Language used in menus and dielogs

English

4. From the Language used in menus and dialogs list, select the
desired language.

5. Tap Apply to confirm the changes, and then OK to return to the
Control Panel window.

The new interface language will become available at the next startup.
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To add new input languages:
1. From the Main Menu, tap Setup.
2. Double-tap Regional and Language Options.

B Control Panel
File Edit View Tools Help
1 ) D - =
Qo Q@ ¥ Psexdr [ | [F (3 X B)
Address | @ Control Panel
; o i 3 P
o= 0 P W w 2 @ [
Bluetooth  Date and Time Device Folder Cptions Fonts Internet Java Keyboard
Options
9 u e
Windows
Frenal

Battery
Devices
¢

Administrative
Taols Calibration
-2-3 =

e -
=
Power Options  Printers and
Faxes

©
Network

Mouse
Connections

3. Select the Languages tab.
Regional and Language Options. @
Regional Dptidgs | Languages | Jdvanced
Text sarvices and input languages
Ta view o change the languages and methods ou can use o erter

text, click Details.

Regional and [csmnersand  Soundsand  User Accounts
Cameras Audio Devices

Language ...

Supplemental languiage support
Most languages are installed by defaul. To install addiional languages.

select the appropriate check box below,
IssallHles far carmples script and right-to-eft languages (including
Thai

Language used in menus and dilags

English

4. Under Text services and input languages, tap Details.

Regional and Language Options:

Fiegional Options | Languages | Advanced

Text services and input languages
To view or change the languages and methods you can use to enter

teit, click Detal.
FTB-1
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5. Under Installed services, tap Add.

Text Senvices and Input Languages Elg‘

Settings | Advanced
Default input language
Selzct one of the installed input languages to use when you start pour
computer.
English [United States] - US v
Installed services

Select the services that you wart for each input language shown in the
list, Use the Add and Remave buttons ta madify this st

English [United States]
&2 Keyboard
- uUs

Add...

Preferences

Language Bar.

Setting Up Your Unit

Selecting the Language of Operation

6. From the Input language list, select the desired language.

7.

8.

Add Input Language E‘El
Tnput language:
French [Canada] v

If necessary, from the Keyboard layout/IME list, select the desired

option.

Tap OK to confirm.

9. Repeat steps 5 to 8 for all the languages that you want to add.

10. Tap Apply to confirm the changes, and then OK to return to the

Control Panel window.

The added keyboards are available immediately. You can now switch from
one input language to another.
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To switch from one of the available input languages to another:

1. From the unit’s keypad, press the -—.'/ 9- button to display the

on-screen keyboard.

2. From the on-screen keyboard, tap EP] to display the list of available
input languages.

3. From the list of languages, select the desired one.
You are now ready to start entering text in the selected input language.

Note: Modifying the input language does not modify the language of the
interface.

To modify the language of the VLC media player:
1. Close the Mini Toolbox window.

2. On the Windows taskbar, tap Start, then select All Programs >
VideoLAN > VLC media player.

3. From the menu, select Tools > Preferences.

£ VLC media player
Media Playback Audio  Yideo Wigw  Help

(> (el EfEm) @ ]

1.00x | | --:--/-

4. Under Language, select the desired language from the list.

By default, the language is set to Auto, to follow the Standards and
formats setting of Windows, but you can select any other language.

5. Tap Save to confirm and close the application.

Note: This operation has no impact on the date and time formats in Windows
Embedded Standard and in the Mini Toolbox applications.
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Setting Date and Time Formats

The current date and time are displayed at the bottom of the Main Menu.
You can modify the format in which the date and time are displayed.
For information on how to adjust the date, the time, and the time zone,

see Adjusting the Date, Time and Time Zone on page 80.

Note: Modifying location, date and time settings will affect some of the
Windows Embedded Standard settings.

To set date and time formats:
1. From the Main Menu, tap Setup.

2. Double-tap Regional and Language Options.

B Control Panel Q@l
Fle Edit View Toos Help &
¢} O /"15ear[h Folders : X ¥ @m-

Address | (@ Control Panel v EYco

Administrative  Battery Bluetooth  Date and Time Keyboard

Folder Options ~ Fonts Internet
Taols Calibration Devices

Options

W = 0 X W v 2 @ g =

D @ 5

Mouse Network  Power Options P
Connections

r Accounts  Windh

E d  Use Windows
Audio Devices Firewal
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78

3. Select the Regional Options tab.

Rewional and Language Options E‘E‘

Fegional Optiors | snguages | Advanced

Standards and formats

This option affects how some progiams format numbers, curtencies,
dates. and time.

Select an item to match its preferences, or click Customize to choose:
your own fomats:

Customize..

Samples

Mumber:  [123 456,783 00
Curtency:  [5123,456.789.00

|
|
Time: R |
Shotdate:  [g/5/2010 |
Long date: [ Thursday. August 05, 2010 |

Location

To help services provide you with local information, such as news and
weather. select your present location:

United States v

4. Under Standards and formats, select the desired language. This will

determine the date formats available for the time as well as the short

and long dates.
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5. If necessary, refine the settings as follows:

5a. Tap Customize to display the detailed settings.

Regional and Language Options

Regional Optiors | Languages | Advanced

Standards and formats
This option affects how some progiams format numbers, currencies,
dates. and time
Select an ftem to match its preferences, of click Customize to choose
your own formats:

5b. Select either the Time or Date tab, depending on the settings that
you want to modify.

Customize Regional Options E|§|
Mumbers | Cunency| Time | Date

Sample

Time sample: 5:45:25 PM

Time format:

[ H -
Timesepastor |
AM symbol _

Time format notation
h=hour m=minte s=second t=amorpm

h=12hour
H =24 hour

hh, rm, ss = leacing zer0
h.m, 3 = na leading zera

6. Modify the settings.

7. Tap Apply to confirm the changes, and then OK to return to the
Control Panel window.
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Adjusting the Date, Time and Time Zone

Note: Only administrator-level users can adjust the date, time and time zone.

The current date and time are displayed at the bottom of the main window.
When saving results, the unit also saves the corresponding date and time.

Note: A dedicated clock battery keeps the date and time accurate.

For information on how to modify the format in which the date and time
are displayed, see Setting Date and Time Formats on page 77.

Note: Modifying date and time settings will affect some of the
Windows Embedded Standard settings.

To adjust the date and time:
1. From the Main Menu, tap Setup.

2. Double-tap Date and Time.

B Control Panel g@l
Fle Edt View Toos Hep "
€] 9 /"15ear[h Folders : X ¥ @m-
v | ] co

Address @ control Panel
= g 2 - ~pn A ] &
Fa - = q
W = QX B v F @ g &
Administrative Battery Bluetooth | Date and Time Device Folder Cptions Fonts Internet Java Keyboard
Taols Calioration  Devices Manager Options

H @ B L8R8, e

Mouse Network Power Options  Printersand ~ Regional and  Scanners an d  Soundsand User Accounts
Connections Faes  Langusge.. Camerss  AudoDevices
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3. Select the Date & Time tab.

Date and Time Properties

e Zonz | Internet Time

Time:

=)

FEEETE ~ | | 2010 3 l N
EE

.Q P
1tz 3 4+ B e 7 . a

8 9 10 11 12 13 14
15 16 17 18 19 20 21

22 23 24 25 26 27 2 u u
N
29 30 31
9:153:43PM | ¥
Currert time zone: Eastern Daylight Time:

4. Modify the settings according to your needs.

5. Tap Apply to confirm the changes, and then OK to return to the
Control Panel window.
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To change the time zone:

1.
2.

3.

From the Main Menu, tap Setup.

Double-tap Date and Time.

B Control Panel = |
Fle Edit View Tools Help

€) Q ¥ | Pseen [Broees | [ 3 X ) -
address @ control Panel
9@ = 0

Administrative Battery

V‘GD
=

$» v B @

(i

Bluetooth | Date and Time

Device Folder Options Fonts Internet Java Keyboard
Tools Calibration Devices Manager Options
D @ % o e 2 9 @ e
) = = =z ; 2
Mause Network  Power Options Printersand  Regionaland Scanmersand  Soundsand  User Accounts  Windows
Connections axes Language . Cameras  Audio Devices Firenal

Select the Time Zone tab.

Date and Time Properties

=
£

Automatically adjust clock For daylight saving changes

4. Modify the settings according to your needs.

5. Tap Apply to confirm the changes, and then OK to return to the
Control Panel window.
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Configuring the Power Management Options

Note:

To get the optimum performance out of your FTB-1, your unit comes with
three predefined sets of parameters (schemes) to manage power.

When you do not use the unit for a while, the display may be turned off to
save power. You can also configure the unit to go into standby or
hibernation mode after the specified duration has expired (see Turning On
or Off the Unit on page 29).

For all of these actions, you can set idle durations for AC adapter/charger
and battery operation. The values that you set are kept in memory even
when you turn the unit off.

When the backlight is turned off, the unit operation is not interrupted. Press
any key or touch anywhere on the screen to return to normal operation.
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The table below indicates the default values that are included in each of
the predefined power schemes.

Power Scheme Action ‘::vc:‘::el:tce ::Is R;::ti:.ge:n
Standard Turn off monitor Never After 5 minutes
gs;efzeuc]tsd by System standby Never After 15 minutes

System hibernates |Never After 30 minutes
Always On Turn off monitor Never Never
System standby Never Never
System hibernates |Never Never
Max Battery Turn off monitor After 15 minutes |After 5 minutes
System standby After 30 minutes |After 15 minutes
System hibernates |After 45 minutes |After 30 minutes

Note: The Turn off hard disks setting is not taken into account (not applicable).

You can either modify one of the existing power schemes or create one

(based on an existing power scheme).

properly.

CAUTION

Your unit has been designed to manage power as well as battery
alarms automatically. Never modify the parameters that appear on
the Alarms tab. Doing so WILL prevent the unit from working
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To select a power scheme:

1.
2.

4.

From the Main Menu, tap Setup.

Double-tap Power Options.

B Control Panel

File Edit View Tools Help

@ - ¥ Posewan [Frroes | [ 3 X ) [F-

o

Address @ control Panel v Be
— p— ~a A h P
i ] s
B o= 0 2 W w & & &=
Administrative Battery Bluetooth  Date and Time Device Folder Options Fonts. Internet Java Keyboard
Tools Calibration Devices Manager Options
T @ . 0 2 9 @ e
\,) = = b4 2
Mouse Network Paower Options  fPrinters and  Regional and  Scannersand  Sounds and  User Accounts Windows
Connections Faxes Language ... Cameras Audio Devices Firewal

From the Power Schemes list, select the desired predefined set of
parameters.

Power Options Properties f'z\

Power Schemes | alsims | Power Meter | Advanced | Hibemate|

§. Selsct the powst scheme with the most appropiiats settings for
3 this computer. Mate that changing the settings below will modify
the selected scheme.

Pawer schemes

Save &z Delete

Sattings for Always O powst scheme

Wwhen computer is ﬂ% Plugged in Eu‘?mng an
oo

Tumalf monitor. | Never v| [Never v
Turm off hetd disks: | Newer w| [ Hever v
System standby ‘ Mewer v ‘ | Never v|
System hibernates: | Never v| [Never v

Tap Apply to confirm the changes, and then OK to return to the
Control Panel window.
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To modify a power scheme:

1.
2.

4.
5.

From the Main Menu, tap Setup.

Double-tap Power Options.

B Control Panel

File Edit View Tools Help

<] Q - | P [Fyrders | [ B X ©) [E-
Address ‘[} Control Panel ”‘ =2
. — 2 - 4 Ch, 4
W o= 0 X W w = s &
Bluetooth  Date and Time Device Folder Options Fonts. Internet Java Keyboard

Administrative  Battery
Manager Optons

Tools Calibration Devices
D @ 2 0 8 9 =

Power Options | Printersand - Regionaland  Stamnersand  Soundsand  User Accounts
Connections Faxes  language.. Cameras  Audio Devices

&

Windows

Network
Firewal

Mouse

From the Power Schemes list, select the predefined set of parameters
that you want to modify or on which you want to base your new
scheme.

Modify the parameters to your needs.

Tap Save As.

Save Scheme

Save this power scheme as;
lways Ori |

H Cancel ]

[ ok

If you want to modify the existing power scheme, keep the name
as is, and then tap OK.
OR

» If you prefer to create a new power scheme, enter a new name,
and then tap OK.

>

6. Tap Apply to confirm the changes, and then OK to return to the
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FTB-1



FTB-1

Setting Up Your Unit
Configuring the Internet Options

Configuring the Internet Options

You can browse the Web directly from your unit, provided that you have
access to an Internet connection and that the Internet options are
configured properly.

If you are not sure about how you should configure your Internet access,
contact your network administrator.

To configure the Internet options:

1.
2.

5.

From the Main Menu, tap Setup.

Double-tap Internet Options.

B Control Panel g[gl
Fle Edit View Toos Hep "
€ D - ¥ | Osean Folders X ¥ @
Address | @ control Panel v a Go
B = 0 X W L i € s &=
Java Keyboard

Administrative  Battery Sluetooth DasteandTme  Device  Folder Options  Fonts
Tools Calibration  Devices Manager

H @ % b e 2 9 @

Mouse Network  Power Options Printersand  Regionaland  Scannersand  Soundsand  User Accounts  Windows
Connections Faxes Language ... Cameras  Audio Devices Firewal

Go to the Connections tab.

Modify the settings using the information provided by your network
administrator.

Tap OK to return to the Control Panel window.

Setting Other Parameters

You can also configure other parameters via the Control Panel window.
Refer to Microsoft Windows Embedded Standard documentation for
details.
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5 Working with Your Unit

FTB-1

Printing Documents

You can print documents and images directly from your unit by using either
the PDFCreator (for PDF files) or a network printer (for printing on paper).

You can view the PDF files from your unit, using the SumatraPDF reader.
For more information, see Viewing PDF Files on page 92.

To print on a network printer, your unit must be accessible from this
network by Wi-Fi or standard Ethernet. You must also define the printer on
your unit before attempting to access it (see Configuring Network Printers
on page 69).

If you cannot connect your unit to a network, you can use a USB memory
key to transfer the files that you want to print to a computer connected to
the network.

If you need more flexibility and a greater choice of report types, you can
also transfer result files to a computer onto which applications such as
EXFO FastReporter 2 are installed.

Note: Some applications may not offer print functions.
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To print documents:
1. Open a Web browser as follows:

1a. From Mini Toolbox, select the Utilities tab.

1b. Tap the Internet Explorer icon to open the browser.

T Mini ToolBox

Q9 &2 B G e

Bluetooth File Calculator EXFO Connect Client FTB-Care GPS Coordinates
Transfer Wizard Viewer

Internet Explorer Notepad Options Activation Product PUTTY
Registration

2. Select the document that you want to print as follows:
2a. From the menu, select File > Open.

2b. Tap Browse to locate the file that you want to open.

Windows Internet Explorer @

Lock in: | Sereen Snapshet ¥ O&F e m

Fe)

My Recert
Documents:

@

Desktop

-

My Documents

My Computer
File pame: IMG_2010_08_03_13_00_01 ~| [ gpen |
My Networc  Files of type |8 Files v [ Cencd |

2c. Tap Open to load the file in Internet Explorer.
2d. Tap OK to confirm.

3. From the menu, select File > Print.
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4. From the General tab, select the desired printer (PDFCreator by
default).

5. If necessary, tap Preferences to adjust the parameters to your needs.
Note: Ifyou selected a network printer, you can save the whole set of preferences
for future use with the Save As button or simply press
N/ from the unit’s keypad to save the parameters for the current work
session.
6. Tap Print to start the printing process.
7. Ifyou selected PDFCreator, proceed as follows:

7a. Enter the desired information.

# PDFCreator0.9.9 K

Documert Title
[le=#7D:ND ocuments snd Settings\Supenvisorby DocumentshSoteen |

Creafion Date;
[201008057 30335 | [ New |

Modity Date:
201008051 30335 | [ Wow ]

Authr
[5uperviser |

Subject:
[Mairtenance Jab 1 |

Keywords
[ |

Profil
Default v

To view the PDF file
immediately after its ——| [ fer saving openthe document vith the defau program

creation

7b. Tap Save.

7c. Specify a location and a file name and tap Save.
If you have selected the option to view the PDF file after its
creation, the SumatraPDF reader will display the new file.

7d. If necessary, tap [ to close the SumatraPDF window.

8. Tap [ to close Internet Explorer and return to the Utilities tab.
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Viewing PDF Files

You can view PDF files directly from your unit using the SumatraPDF
reader. For more information on the available features for this reader, refer
to the SumatraPDF online help.

To view PDF files:

1. From Main Menu, select File Manager.

2. Browse through the folders to find the desired PDF file.
3. Double-tap the file.
4

The file opens automatically in the SumatraPDF application.

&= My Report.pdf E@E|
File View GoTo Zoom Settings Help
Page: 11 < (&  Find: Ay

.........

Note: You can access the online help directly from the Help menu of the
SumatraPDF application. You will need a connection to the Internet to view
the online help.
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Taking Screen Captures

You can take captures of what is displayed on your screen, directly from
your unit. This could be useful for troubleshooting when you need another
person to have a look at a specific configuration or problem. You could also
use this tool for training purposes.

If you want to capture images of the fibers that you examine with the fiber
inspection probe, you can use the capture feature of the probe instead.

For more information on how to modify the default file format and
destination folder, see Setting Storage Parameters for Screen Captures on
page 96.

» Images are saved using the defined file format. By default, images are
created in .bmp format, but you can modify this parameter.
By default, they are kept in the following folder:

D:|\Documents and Settings\User _currently logged on|My
Documents|Screen Snapshot

where User_currently logged on corresponds to the user name of the
person that is currently logged on the unit.

It is possible to modify the folder in which images are automatically
saved.
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Note:

Note:

» By default, the application generates file names as follows:

IMG_[YEAR] _[MONTH]_[DAY]_[HOUR]_[MINUTE]_
[SEQUENTIAL NUMBER].bmp

Example:
For a screen capture taken on August 20, 2010, the file name could be:
IMG_2010 08 20 13 23 01.bmp.

The HOUR value will appear in a 24-hour format, regardless of your unit's
time settings.

The SEQUENTIAL NUMBER value is used to differentiate fio captures that
would have been taken at the same date and time.

» There are two ways to capture images: a quick mode (the screen
capture tool is automatically closed as soon as the capture is made)
and a multiple-capture mode (the screen capture button is part of a
floating toolbar that remains available until you close it). By default, this
toolbar is located in the lower-right corner of the screen. However, you
can move it to a location that better suits your needs.
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Taking Screen Captures

To take only one screen capture:

From the unit's keypad, press the ¥Z%/@ button and hold it down for
about 3 seconds.

The screen capture is automatically taken as soon as you release the
button (a sound and visual effect typical of a camera taking a picture
indicate that the capture is complete).

If a keyboard is connected to your unit, you can also press the
PRINT SCREEN key.

To take several screen captures:

1. From the unit's keypad, press the ¥Z%/@ button.
2. Once the on-screen keyboard is displayed, tap the l@ button.
3. From the floating toolbar, tap the button.

The screen capture is automatically taken (a sound and visual effect typical
of a camera taking a pictureindicate that the capture is complete).
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Setting Storage Parameters for Screen
Captures

Note:

96

You can modify the file format of the screen captures as well as the
destination folder, that is the folder to which the captures will be sent.

» By default, images are saved in .bmp format, but you can configure the
application to save them in .jpg or .png format.

» By default, images are kept in the following folder:

D:|\Documents and Settings\User_currently logged on|My
Documents|Screen Snapshot

where User currently logged on corresponds to the user name of the
person that is currently logged on the unit.

You can select any other folder as the destination either locally on your
unit, on a USB memory key.

If the specified folder is no longer available (folder name has been
modified, folder has been deleted), the screen captures will be sent to the
default folder. Similarly, if you have defined a destination folder on a USB
key and this key is not connected to your unit when you take screen
captures, the latter will be sent to the default folder.
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To set the default image format:
1. From the Main Menu, tap System Settings.

2. If necessary, from System Settings, tap Display & Sound.

B2 System Settings

EEX
g

System

Calibration points: ‘9 v-l

On-screen keyboard

On-Screen Keyboard
Optians...

Display and Sound Settings -
Backlight [ Menw |
J' Display & Sound
—— |/ tomatic Logon
Volume
D Mute Audio Mixer... ‘ ‘ Sound Options... |
Touchscreen
Calibrate... H Touchscreen Options... |

Screen snapshot

Screen Snapshot Options...|

3. Under Screen snapshot, tap the Screen Snapshot Options button.

4. Under Image format, select the option corresponding to the desired

format.

ScreenSnapshot Configuration,

£

Image format
() BMP - Windows Bitmap

(") PNG - Portable Network Graphics

(@) JPEG - Joint Picture Expert Group

Destination folder

|D‘\Ducumenbs and SettingsiMy New UseriMy DocumentshScreen E‘m‘l

Capture hot Key

|Frm5£reen

5. Tap OKto confirm the changes and close the window.
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To modify the destination folder:
1. From the Main Menu, tap System Settings.

2. If necessary, from System Settings, tap Display & Sound.

System Settings E\\E\fgl
Sysh
Display and Sound serﬁ:';s %

Backlight Men
J’ Display & Sound

S ) Automatic Logon

Volume Startup Applications
-
4

D Mute ‘ Audio Mixer... ‘ ‘ Sound Options... |

Touchscreen

Calibration points: ‘9 v| Calibrate... H Touchscreen Options... |

On-screen keyboard Screen snapshot

On-Screen Keyboard
Screen Snapshot Options...|

3. Under Screen snapshot, tap the Screen Snapshot Options button.

4. Under Destination folder, tap Browse.

ScreenSnapshot Configuration b?

Image format

() BMP - Windows Bitmap
(") PNG - Portable Network Graphics

(@ IPEG - Joint Picture Expert Group

Destination folder
|D‘\DD:umem5 and Settingsiy New UserMy DocumentshScreen E‘m‘l

Capture hot Key

|F'r' intScresn |

Cancel
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From the Browse for Folder window, select the folder that you want to
use to store the screen captures. If necessary, you can create a folder.

(&} Desktop
= (5) My Documents
2 iy mMusic

112} ty pictures
(0 My Pawer Meter Results
(5 Sereen Snapshot

# 1 My Computer

# % My Network Places

& RecycleBin

[(Makerewrager | [ ok ][ coneal |

When your selection is made, tap OK.

Tap OK to confirm the changes and close the window.
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Reading Audio and Video Files

Your unit is equipped with the VLC media player which enables you to read
audio files and to view video files (such as .avi and .divx). This could be
especially useful if your company wants to use multimedia files for training.
The player can read files that are stored on your unit, on a USB memory
key, on a network folder, or even on a Web site.

IMPORTANT

The VLC media player does not support the Flash format. If you
want to read files in this format, you will need to install the Adobe
Flash Player application (see Installing Adobe Flash Player on Your
Unit on page 102).

For more information on how to configure the language of the media
player, see Selecting the Language of Operation on page 72.

For more information on how to use the video player, refer to the
VideoLAN online help.
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To read video or audio files:
1. From Mini Toolbox, select File Manager.

2. Locate the video or audio file that you want to read.
3. Double-tap the file.

The media player starts reading automatically if the file format is
recognized.

& VLC media player EJE|E|

Media Playback Audic  video Tools  View  Help

]

(> (@) S EW o ]

1,00 | | i1

You can access the online help from the Help menu of the VCL Media
Player application. You will need a connection to the Internet to view the
online help.
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Installing Adobe Flash Player on Your Unit

The Adobe Flash Player application is not installed on your unit by default,
but you can install it if you need to read files in Flash format.

IMPORTANT
EXFO does not provide licenses for Adobe Flash Player. Contact

Adobe to purchase a license that will entitle you to install Flash
Player on your unit.

To download the installation files, you will need a connection to the
Internet. You can either download the files directly to your unit or to a
computer (and transfer them to your unit later using a USB key).

Note: Only administrator-level users can install software under Windows

Embedded Standard. However, when the installation is complete, all users
will be able to read files in Flash format.
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IMPORTANT

Ensure to download the latest installation package for the 32-bit
version of Flash Player for Windows (operating system), and

Internet Explorer (browser). You should retrieve the EXE installer
component.

To install Adobe Flash Player on your unit:

1.
2.

7.

If necessary, turn on your unit.

From your computer or your unit, open a Web browser and go to
http://www.adobe.com/special/products/flashplayer/
fp_distribution3.html.

Locate the most recent version of Flash Player 32 bits.

Under Flash Player 32 bits, locate the entry corresponding to Windows
(operating system) and Internet Explorer (browser).

Save the corresponding EXE installer to a location of your choice (on a
USB memory key connected to your computer or on your unit).

If you have downloaded the file to a USB key, connect the key to your
unit.

Double-tap the downloaded file, and follow the on-screen instructions.

Note: At this point, if you have used a USB memory key to transfer the installation
files to your unit, you can rermove it.

All users are now ready to read files in Flash format.

FTB-1
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Browsing the Web

You can browse the Web directly from your unit, provided that you have
access to an Internet connection.

If you need to modify the Internet options, see Configuring the Internet
Options on page 87. For more information on how to connect to the
Internet using a 3G USB modem key, see Accessing the Internet with a 3G

USB Modem Key on page 106.

To browse the Web:
1. Open a Web browser as follows:

1a. From Mini Toolbox, select the Utilities tab.

1b. Tap the Internet Explorer icon to open the browser.

T Mini ToolBox

3]

Bluetooth File
Transfer Wizard

B G e

Calculator EXFO Connect Client FTB-Care GPS Coordinates

B & <

iewer
Options Activation Product PUTTY
Raaistration
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2. Enter the desired Web address in the address bar and tap the
- | button (located at the right of the address bar) to start browsing.

* Customize Your Settings - Windows Internet Explorer

i8] . exto.com

File Edit View Favorites Help

Wode v B - i v [ihpage - G Took - @-

internet
@ Explorer?7

Welcome Back :
e MNew ook

Are you ready to choose your settings?
Hew look huttons

a) Required settings Hewloak for the Back,
Forward,

Please choose your default search provider. Home and Refresh

Internet Explorer allows you to easily find information on the Weh using any search buttons.

provider.

“Your current default search provider is; Live Search Favorites Center

Pl lect 1 ofthe 2 fall tions: Favarites get friendlier;
ease select 1 ofthe 2 following options Histary 12

easiertn read

D Tabbed browsing

€ mternet 100 v

O Keep my current default search pravider
O Letme selectfram a list of other search providers

Dane

3. Close the window to return to the Utilities tab.
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Accessing the Internet with a 3G USB Modem
Key

Note: Only administrator-level users can install software under Windows
Embedded Standard. However, when the installation is complete, all users
will have the possibility to access the Internet using a USB modemn key.

Your can connect an optional 3G USB modem key to your unit to have a
wireless access to the Internet.

When you receive your modem key, it contains no Subscriber Identity
Module (SIM) card. This means that you will need to:

» Purchase a compatible and unlocked SIM card from a provider offering
3G services. If you need more information on the 3G coverage in your
area, contact your regional EXFO sales representative.

» Have the card activated (you must subscribe to a package of mobile
services).

» Insert the card in the modem key.

The very first time you connect a USB modem key to your unit, the AirCard
Watcher application will be installed automatically on your unit. You will
use this application to establish a connection with the mobile network
whenever you want to work with your USB modem key. You only need to
install this application once.
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IMPORTANT

u » Only the Sierra Wireless 319U keys provided by EXFO are
supported on your unit.

» Before using the USB modem key for the first time, you must
install the most recent System Upgrade and Platform kits for
your unit. To do this, you will need a standard USB memory key
and a computer with an Internet access. You can also retrieve
the kits directly from your unit, but you will need an Internet
access (other that the one that would be provided by the 3G
USB modem key).

» Always turn your unit on before connecting the USB modem
key to it. Otherwise, the USB modem may not be detected

properly.

To upgrade your unit to the latest System Upgrade and Platform
components:

1. If necessary, turn on your unit.
2. Retrieve the latest System Upgrade and Platform Kkits:

2a. From your computer or your unit, open a Web browser and go to
www.exfo.com.

2b. Log on to your My EXFO account.

2c. Under FTB-1, find the System Upgrade and Platform Kkits. If you
need information on how to download the Kits, refer to the
Readme files provided with the Kkits.
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3. Install the retrieved kits on your unit:

3a. Install the System Upgrade. For more information, refer to the
installation procedure provided with the Kit.

3b. Once the installation of the System Upgrade is complete, install
the Platform kit on your unit. For more information, refer to the
Readme file provided with the kit.

Note: At this point, if you have used a USB memory key to transfer the installation
files to your unit, you can remouve it.

You are now ready to install the AirCard Watcher application as explained
hereafter.

To install the AirCard Watcher application on your unit:

1. If necessary, turn on your unit and wait for the startup sequence to
complete.

2. If necessary, insert the SIM card into the USB modem key. For more

information, refer to the documentation that came with your modem
key.

3. Connect the USB modem key to one of the USB ports of your unit.

The installation of the AirCard Watcher application will start
automatically.
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Follow the on-screen instructions.

You will know that the installation is complete when the AirCard
Watcher application starts.

Fa" AirCard Watcher

SIERRA

WIRELESS"

Close the AirCard Watcher application.
Disconnect the USB modem key from your unit.

Reconnect the USB modem key to your unit so that it can be detected
propetly.

All users are now ready to start working with the USB modem key as
explained hereafter.
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To work with a 3G USB modem key:
1. If necessary, turn on your unit and wait for the startup sequence to
complete.

2. If necessary, insert the SIM card into the USB modem key. For more
information, refer to the documentation that came with your modem
key.

3. If necessary, connect the USB modem key to one of the USB ports of
your unit.

4. From the Windows desktop, double-tap the AirCard Watcher icon to
start the application.
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5. Once the AirCard Watcher application starts, tap Connect to establish a
connection with the mobile network.

SIERRA
WIRELESS®

As soon as the connection is established, you are ready to browse the
Web.

Note: If you want to customize the behavior and appearance of the AirCard
Watcher application, refer to the online help provided with the application
(available by tapping ? from the toolbar).

Note: The application will display a warning message if no SIM card has been
inserted in the USB modem key.

Note: Depending on the package that you have purchased with your service
provider and the type of network, you may have to set specific parameters.
If you are not sure on how to proceed or need more information about the
configuration, contact your service provider.

6. When you have finished working, tap Disconnect from the AirCard

Watcher application, and then remove the USB modem key from your
unit.
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Retrieving the GPS Location of Your Unit

Note:

Note:

112

With the optional GPS USB key and the provided GPS utility, you can
retrieve the latitude and longitude coordinates of your unit as well as the
date and time of the reading. You will see either the last known coordinates
or the current ones, depending on if the GPS key can establish a
connection with the GPS satellites or not.

To be able to establish a communication, the unit must be used outdoors
and as far away as possible from buildings and other solid objects.

In addition to viewing the GPS information on-screen, you can copy it to
the Clipboard in two formats: a text string or a URL link. The text string
contains the GPS coordinates as well as a date and time stamp. Once the
information is in the Clipboard, you can paste it to any document or test
report (in editable sections). If your unit is connected to the Internet, you
can even directly paste the URL link to a Web browser to locate your unit
on a map.

IMPORTANT

» Only the Canmore GT-730F(L) keys provided by EXFO are
supported on your unit.

» Before using the GPS USB key for the first time, you must install
the most recent System Upgrade and Platform kits for your unit.
To do this, you will need a standard USB memory key and a
computer with an Internet access. You can also retrieve the kits
directly from your unit, but you will need an Internet access.

Only administrator-level users can install software under Windows
Embedded Standard.
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To upgrade your unit to the latest System Upgrade and Platform
components:

1. If necessary, turn on your unit.
2. Retrieve the latest System Upgrade and Platform Kits:

2a. From your computer or your unit, open a Web browser and go to
www.exfo.com.

2b. Log on to your My EXFO account.

2c. Under FTB-1, find the System Upgrade and Platform Kkits. If you
need information on how to download the Kits, refer to the
Readme files provided with the Kits.

3. Install the retrieved kits on your unit:

3a. Install the System Upgrade. For more information, refer to the
installation procedure provided with the Kit.

3b. Once the installation of the System Upgrade is complete, install
the Platform kit on your unit. For more information, refer to the
Readme file provided with the kit.

All users are now ready to start working with the GPS USB key as explained
hereafter.

Note: At this point, if you have used a USB memory key to transfer the installation
files to your unit, you can rernove it.
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IMPORTANT

u Always turn your unit on before connecting the GPS USB key to it.
Otherwise, the GPS key may not be detected properly.

To retrieve the GPS location of your unit:
1. Go outdoors with your unit.

2. If necessary, turn on your unit and wait for the startup sequence to
complete.

3. Ensure that the GPS USB key is connected to your unit.
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4. From Mini Toolbox, select the Utilities tab, then tap GPS Coordinates
Viewer.

T Mini ToolBox

Utilities

Bluetooth File EXFO Connect Client FTB-Care GPS Coordinates
Transfer Wizard Viewer

The GPS coordinates are displayed.

(&) GPS Coordinates

Latitude: | 467 53 BE.742" N
Longitude: | 71° 10" 972" 'w
Retrieved on:| 1042542011 12:43:00 PM

[ Copy Coordinates l l Copy Hyperlink ]

Status of the connection

I Receiving coordinates ®

Note: Ifyou see “GPS not detected” at the bottorn of the GPS Coordinates
window, this means that the GPS key is not connected to your unit.
Once the GPS key is connected properly, the utility will display “Searching”.
Finally, when a connection can be established with the GPS satellites, the
utility will display “Receiving coordinates”.

Note: As this is the case with any other GPS device, you may have to wait a few
minutes to get a valid GPS signal.

» Tap Copy Coordinates to send the displayed information to the
Clipboard as a text string.

» Tap Copy Hyperlink to send the displayed information to the
Clipboard as a URL link.

5. When your work is finished, tap to close the utility.
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Using the Calculator

You can use Microsoft Calculator directly from your unit.

To use the Calculator:
1. From Mini Toolbox, select the Utilities tab.

2. Tap Calculator.

Using the Text Editor

You can use Microsoft Notepad directly from your unit.

To use the text editor:
1. From Mini Toolbox, select the Utilities tab.

2. Tap Notepad.

Accessing Other Tools

Your unit comes with free tools such as Wireshark to help you troubleshoot
networks. For more information, refer to the online help provided with
these tools.

You can also purchase advanced software tools if you need more flexibility
and possibilities. Online help is available from these applications to guide
you.

If you want one or more of these tools to start automatically at unit startup,
see Selecting the Startup Application on page 65.

To access tools:

1. From Mini Toolbox, select the Test Tools tab.

2. Tap the icon corresponding to the tool that you want to use.
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6 Using the Optional Built-In
Power Meter and VFL

FTB-1

Note:

The FTB-1 can be equipped with an optical power meter to measure
absolute power (dBm or W) or insertion loss (dB). The power meter can
detect modulated signals (1 kHz, 2 kHz, and 270 Hz).

The FTB-1 can also include a visual fault locator (VFL) to inspect or identify
fibers.

If you have purchased a module with an inline power meter, you can also
take measurements with this power meter instead of using the built-in
power meter.

For more information on how to use the power meter or the VFL, refer to
the power meter online help.

The appearance of your application may vary depending on the options
that you have purchased and the module you are using. The illustrations
presented hereafter show the application as it appears when the unit is
equipped with a built-in power meter, a built-in VFL, and a module with an
inline power meter.
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To access the built-in power meter or the VFL:
1. From Mini Toolbox, tap Power Meter and VFL.

FTB-730-23B-EA
( OTDR 1310/1550 nm (SM)
[l} S/N:540683

[

Advanced OTDR Automatic OTDR Fault Finder ioLM

[
Ref./Template

atlf 11/13/2013 11:57 AM

2. Ifthe module that you are using with your platform is equipped with an
inline power meter, tap the item corresponding to the power meter
that you want to use.

W Mini TS %

FTB-730-236-04B-0PM-EA
OTDR 1310/1550/1625 nm (SM)
[l‘ SN:550318

Note: If you want to use the built-in VFL, select either Power Meter and VFL or
VFL, depending on the configuration of your unit.

Note: You can access the online help of the power meter and the VFL by tapping
the button from the power meter application.
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7 Inspecting Fibers with a Probe

The fiber inspection probe (FIP) is used to find dirty or damaged
connectors by displaying an enlarged view of the connector surface. You
can connect a probe to your unit to view fiber ends.

Your unit supports both the probes of the FIP-400 and FIP-400B series.

Fiber inspections are made using the ConnectorMax (FIP-400) or the
ConnectorMax2 (FIP-400B) application, depending on the probe that you
use. By default, you will be prompted to select the application with which
you want to work. If you prefer, you can configure the unit to always start
your favorite application directly instead (see Selecting the FIP Startup
Application on page 67).

For more information on how to work with the probe, refer to the
ConnectorMax or ConnectorMax2 online help.

To inspect fibers with a probe:
1. Connect the probe to your unit.

» For a probe of the FIP-400 series, connect it to the probe port.

» For a probe of the FIP-400B series, connect it to one of the USB
ports.

Top panel

L
&

(053]

L adel” (

..}
i 1

(.

Fiber inspection probe port
(for FIP-400 probes)

USB host ports
(for FIP-400B probes)

2. From the Main Menu, tap Probe.
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Note:

Note:

3. If the unit prompts you to select an application, tap the button
corresponding to the probe that you want to use to start the
corresponding application.

Fiber Inspection Probe

Al O

Connectoriax Connectorhax2
FIP-400 FIP-4008

Cancel

If you have not updated the ConnectorMax product lately, the
ConnectorMax2 application may not be installed on your unit. In this case,
you will not be presented with a choice of applications. The ConnectorMax
application will start autommatically, enabling you to work with the probes
of the FIP-400 series. If you also wish to be able to work with probes of the
FIP-400B series, you will need to install the most recent ConnectorMax Rit.

You can access the online help by tapping the button from the
ConnectorMax or ConnectorMax2 application.
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FTB-1

You can copy, move, rename, delete files and folders directly on your unit.

You can transfer files from your unit to a USB memory key or a computer.
You can also transfer data from a storage device or a computer to your unit.

Your unit is equipped with the following ports and devices for data transfer:

» Two USB 2.0 ports to connect a memory key or a USB to RS-232
adapter (see Using the USB to RS-232 Adapter on page 136.)

» an Ethernet port to connect to a network (for transfer via VNC or
Remote Desktop - see Accessing Your Unit Remotely on page 157)

» internal Wi-Fi device (optional) to connect to a wireless network

» internal Bluetooth device (optional) to transfer data via Bluetooth.
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From Main Menu, tap System Info.

2. Select Platform.

To view the free disk space on your unit:

The free disk space is displayed next to the Available Flash on “D:\

(APP)” item.

System Information

sty

N/
Information
Flatform

Model

Serial number
Total RAM
Total Flash

About

Available Flash on "D:\ (APF)"
Versions

- BIOS

-EC

- Hardware

- System image

- System upgrade

Battery manufacturing date
Battery number of cycle made

Available Flash on "C:\ (SYSTEM)"

Value
FTB1-332974
FTB-1
532974

1018 MB
16384 MB
402 MB
11435 MB

1.13.0.0
4.5.0.0
1.0
1.0.0.18
1.0.0.107
1/19/2007
39

Close

From Main Menu, select File Manager.

3. When you have finished, tap OK to close System Information.

To manage files or folders on your unit only:
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To transfer files or folders between your unit and a USB memory
key:

1. Connect the USB memory key to the USB port.

2. From Main Menu, select File Manager.

The list of available drives and folders should include the memory key
(Removable Disk). You can now manage your files and folders as you
wish.

Note: If you do not see the memory key, close File Manager and reopen it. You
can also use the Refresh option from the View menu.

3. When you have finished, remove the memory drive.
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Transferring Data via Bluetooth

If your unit is equipped with the optional Bluetooth device (internal), you
can transfer data between your unit and a computer using the Bluetooth
technology. By default, both the Bluetooth and Wi-Fi devices are enabled,
but not connected to a network.

If you have disabled the devices, you must enable them before trying to
transfer data via Bluetooth (see Enabling or Disabling the Bluetooth and
Wi-Fi Devices on page 141).

The computer that you use must run Windows XP SP3 or later; otherwise,
there could be problems during data transfer. The computer must also be
equipped with a Bluetooth device and be configured properly.

Note: If you prefer to use devices such as BlackBerry smartphones instead of a

computer for data transfer, you must ensure that they are
Bluetooth-compatible and configured properly.

Some devices only allow data transfer between devices of the same make.
In this case, you will need to use another type of device or a standard
computer to transfer data from your FTB-1 unit.

Your unit must be located within a 9-meter area from your computer
(limitation of the Bluetooth technology).

If you need to transfer large files (more than 1 Gb), use a USB key, or
connect to a Wi-Fi or an Ethernet network.

The procedure presented hereafter explains how to transfer data from your
unit to a computer. Data transfer from the computer to your unit is similar,
except that data will be sent using the Bluetooth Transfer Wizard of the
computer (Send a file option) and received by the unit (Receive a file
option).
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To transfer data via Bluetooth:
1. Configure your unit as follows:

1a. From the Main Menu, tap Setup.

1b. Double-tap Bluetooth Devices.

1c.

B Control Panel
File Edit View Tools Help

© /.-“Search [Eroeers | [ 37 X 6 [FED-

4

-~ V|GD
P B @B @ & =

jate and Time Device Folder Options Fonts Internet Java Keyboard

accress (@ Contol Panel e

@ = 0

Administrative Battery Bluetooth

Tooks Calibration Devices Manager Options
T @ B Ly e £ 9 @ e
J = = b4 7
Mouse Metwork Power Options  Printersand  Regionaland Scanmersand  Soundsand  User Accounts  Windows
Connections Faxes Language .. Cameras  Audio Devices Firewall

From the Options tab, under Discovery, select the
Turn discovery on check box.

Bluetooth Devices @l

Devices | Options | COM Ports | Hardwars

Discovery
To allows Blustooth devises to find this computer, select the
fallowing check box

Turn discovery on

A To protect your privacy. tun on discovery only when you
want a Bluetooth device to find this computer.
Cornzctions

Use these seftings ta cantrol whether a Bluetooth
device can connect ta this complter

Allow Blustooth devices to connect to this computer
[#] &lett me when a new Bluetaath device wants to connect

[[]5how the Bluetoath icon in the notification area

Leam more about Bluetooth settings. Fiestore Defaults

[ ok ][ cance J[ Ay |

1d. Ensure that the Allow Bluetooth devices to connect to this

computer check box is selected.

1e. Tap OK to confirm.
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2. Configure the computer as follows:

2a. On the computer, from Control Panel, double-click Bluetooth
Devices.

2b. From the Options tab, under Discovery, select the
Turn discovery on check box.

2c. Ensure that the Allow Bluetooth devices to connect to this
computer check box is selected.

2d. Tap OK to confirm.

3. Onthe computer, click the Bluetooth icon (located on the taskbar) and
select Receive a file.

4. On your unit, from Mini ToolBox, select the Utilities tab.
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T Mini ToolBox

Utilities

Managing Data
Transferring Data via Bluetooth

5. Tap Bluetooth File Transfer Wizard.

5
Bluetooth File Calculator
Transfer Wizard
Internet Explorer Notepad
TightVNC Server  Update Manager
Start

B G

EXFO Connect Client

FTB-Care
Options Activation Product
Registration

= )

USB Data Mover VPN Installer

o

GPS Coordinates
Viewer

'WiFi Connect

4 Bluetooth File Transfer Wizard

Do you want to send ar receive a file?

6. From the Welcome window, tap Next.

7. Select Send a file and tap Next.

@ Send afle

O Receive afie

<Back ][ MNew> ] [ Cancel

© ff 13/13/2013 12:34PM
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8. Select the computer to which you want to transfer data as follows:

8a. Tap Browse.

128

4 Bluetooth File Transfer Wizard gl

Select where you want to send the file. GB@’

Send the fils o the computer or device below, or click Browse to chooss a diffsrent
computer or device.

Sendla [WKSQC00845 (|[Browse._|

Use a passkey (o ensure thal you are sending the file to the correct device. The passkey
alsa protects the file from being viewed by others while it is sent to the other device.

Use a passkey

Passkey: ‘ mypasskey |

[ <Baok ][ mews | [ Cancel |

8b. Select the desired computer, and then tap OK to confirm.

Computers {workstations, servers. laptops. PDAs)

KSQC0D845
[New device

i ffyou dont see the devics that you want to add, make sure that it is tumed an, Follow the
setup instructions that came with the device, and then click Search Again
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9. If you want to use a passkey, select the corresponding check box and

enter the passkey.

% Bluetooth File Transfer Wizard

Send the file to the computer or device below, or click Browse to choose a different
computer or device.

Select where you want to send the file. 9@’

&

Send lo [wks0conaes | [ Browse

Use a passkey to ensure that you are sending the fi ta the camect devics. The passkey
also protects the fils from being viewed by others whie it is sent to the ather device

Use apasskey
Passkey: ‘ mypasskey |

[ «Back ][ Mew> | [ cCancel |

When you have finished, tap Next.

10. Tap Browse to select the file that you want to send to the computer.

3 Bluetooth File Transfer Wizard 3]

Select the file you want to send 9®
To choose a fil. click Browse
Fie name: [IMG_2010_08_27_15_53_01 pg (] (CBrowse.. ] ’
[ <Back ][ New> ] [ Cancel |

11. Select the file, tap Open to confirm,

and then Next.
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12. On the computer, when the application prompts you, allow the
connection and enter the passkey if necessary.

Note: Once you have established a secured connection using a passkey, this
passkey is kept in memory both on your unit and on the computer until you
remove this connection (Setup > Bluetooth Devices > Devices) or change
the passkey.

13. On the computer, click Finish.

14. From the Bluetooth File Transfer Wizard on your computer, if
necessary, modify the name of the received file and the storage
location. Click Next to save the file. Click Finish to close the wizard.

15. On your unit, tap Finish to close the Bluetooth File Transfer Wizard.
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Connecting to a Wireless Network

If your unit is equipped with the optional Wi-Fi device (internal), you can
connect to a wireless network and benefit from all resources that are
available on this network. You can transfer data exactly as you would do
from an Ethernet network. By default, both the Bluetooth and Wi-Fi devices
are enabled, but not connected to a network.

If you have disabled the devices, you must enable them before trying to
connect to a wireless network (see Enabling or Disabling the Bluetooth
and Wi-Fi Devices on page 141).

To connect to a wireless network:

1.

If it is not already done, share all the required folders both on your unit
and on your computer. If you are not sure on how to proceed, contact
your network administrator.

If it is not already done, configure the firewall as follows:

2a.

2b.

2C.

From Main Menu, tap Setup.

Double-tap Windows Firewall.

B Control Panel gg‘
Fie Edt Vew Tods Help i
€} D [ O seach Folders xX 9 m-
acdress |G contol Panel v B
= e 2 — - A ] y
Y - £, E
w o= 0 P 9w g @ g =
Administrative Battery Bluetooth  Date and Time Device Folder Cptions Fonts Internet Java Keyboard
Todls Calibration  Devices Manager Options
R EEEE RN
- = = z 7
Mouse Metwork Power Options Printersand  Regional and S e nd ounds and  User Accour

r Canners ar S
Connections Fawes  langusge.. Camerss  AudioDevices

Select the Exceptions tab.
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2d. Ensure that the File and Printer Sharing itemn is selected.

" Windows Firewall

| General | Exceptions | Advanced|

Windows Firewallis blocking incoming network connections, except forths
programs and services selected below. Adding exceptions allows some programs
o work better but might Increas yoLr scurty risk

Frograms and Services:

Name -

_
Fil 3nd Printer Shating

Zila Server

erf (Java)

eintenance Servics

lessage Queuing

PluginTest 2pp

CIFNRP 4

Remate Deskiop

[ UPn? Framework

RV T Media Plaver

[ AddProgam... | [ AddPor. ][ Edt ] [ Delete

[ Display a netfication when Windows Fiewal blacks 2 program

What are the risks of allowing exceptions?

2e. Tap OK to confirm.

On your unit, from Mini ToolBox, select the Utilities tab.
4. Tap WiFi Connect.

T Mini ToolBox

Utilities

B 2 B &G e

Bluetooth File Calculator
Transfer Wizard

EXFO Connect Client FTB-Care ‘GPS Coordinates

Viewer

e B ©B & £

Internet Explorer

System Info
Notepad ‘Options Activation Product PuTTY
Registration
G : —
= - A )
g L n = | - !
TightVNC Server  Update Manager USB Data Mover
Start

VPN Installer

WiFi Connect

5. Tap OK to acknowledge the message on how to display the list of
wireless networks.
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Double-tap Wireless Network Connection.

" Network Connections

File Edit Vien Tools Advanced Help

Qo - © - (F P seaahr [ Folders

Addr

| & network Comnectons

F (& X ¥ |-

LAN or High-Speed Internet

Bluetooth

Network, ..

Wizard

ENE

Local Areal Wireless
Connectior Network

Personal Area Network

-
%
New Network Setup
Connect. Wizard

Connection

If your unit is already connected to a wireless network, tap View
Wireless Networks to display the list of wireless networks.

General | Suppart|

Connzstion
Status:
Network
Duration:
Spesd

Signal Strength

Aoty

Sent

Bytes

Connested
EF0_Gusst
171734
54.0 Mbps

anlll

1] Received
—

13556

Propetties | [ Disable

([ view wistess Netwaris | )

Close
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8. From the Wireless Network Connection window, select the wireless

network to which you want to connect.

eless Network Co

Network Tasks

& Refresh network list

<2 Set up a wireless netwark.
for a home or small office

Related Tasks

) Learn about wireless
networking

¢ Change the order of
preferred networks

4§ Change advanced
settings

9. Tap Connect.

Choose a wireless network

Click anitem in the list below ko connect ta & wirsless network in range ar to get more

EXFO_Guest

Unsecured wireless network

v PLATFORM

[

ailll
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10. If the network is protected by a network key (password) enter it in the
corresponding boxes and tap Connect.

Wireless Network Connection @

The netwark PLATFORM requires a network key (slso called a WEP key or WPA key). A
network key helps prevent unknown intruders from connecting to this network.

Type the key, and then dick Cannect.

Network key: R
Confirm network key: sressenensl

Connect Cancel

Note: Since all networks are different, you may also need to configure other
parameters before being able to transfer data via Wi-Fi. For information on
the configuration specific to your network, contact your network
administrator.

As soon as the connection is established, you can start working with the
selected wireless network. When you have finished, from the Wireless
Network Connection window, tap Disconnect to stop communication
with the wireless network.
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Using the USB to RS-232 Adapter

If you want to transfer data between your unit and a device that is only
equipped with RS-232 (serial) ports, you have to use a USB/RS-232 adapter.

IMPORTANT
Only the USB/RS-232 adapters sold by EXFO are supported.

Once the adapter has been detected, the unit assigns it a COM port number
(values begin at COM 3). This COM port number is kept in memory even
when you turn the unit off. This means that next time you connect the
same adapter to any of the USB ports, the unit will recognize the adapter
and identify it with the saved COM port number.

The communication between your unit and the device is established using
the PuTTY application.
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To use the USB/RS-232 adapter:
1. Turn on both the unit and the serial device.

2. Connect as shown. You can connect the USB end of the adapter to any
of the USB ports.

Serial end

Serial
device D

USB/RS-232
adapter

Note: If the device that you want to use is a computer (not equipped with USB
ports) you may want to use a null-modem serial cable as an “extension
cable” between the device and the USB/RS-232 adapter.

The adapter will be detected automatically on your unit.
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3. From your unit, retrieve the COM port of the adapter as follows:

3a. On your unit, from the Main Menu, select Setup.

3b. Double-tap Device Manager.

B Control Panel

File Edit View Tools Help

Q © T Psaa [Froes | [ 3 X V) E-

address [ Control Pane!

Tools Calibration Devices

D @ % L e 2 9

" — =) - A
ke 5 g z
4 ek (9| ¥ =@
Administrative Battery Bluetooth Date and Time Dewvice Folder Options Fonts
Manager

Mouse Network  Power Options Printers and  Regionaland  Scannersand  Soundsand  User Accounts

Connections Faxes  Llanguage.. Camerss  AudioDevices

Internet
Options

82

(28

Java

&

Windows
Firewall

Keyboard

3c. Expand the Ports (COM & LPT) list to retrieve the COM port
number that has been assigned to the adapter and write it down.

L, Device Manager

File Action View Help

== [ S 2060 A

SN YFTB1-533000

el Advantech Proprietary Devices
) 1 gatteries
©

Blustooth Radios
- i Computer
Pl Disk drives
)-8 Display adapters
-7 EXFO Modules
/(&g Human Interface Devices
)43 IDE ATA/ATAPI controllers
- Keyboards
(-7 Mice and other pointing devices

5
o

G
[+ B8 Network adapters
=% Ports (COM & LPT)
¥ Communications Port {COM1)
) 3

-4 Processors

- Bl Ramdisk

-2 Secure Digital host contrallers

- @, Sound, video and game controllers

=

=

3d. Close the Device Manager.
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4. From your unit, configure the communication parameters as follows:

4a. On your unit, from Mini ToolBox, select the Utilities tab, then tap
PuTTY.

4b. Configure the parameters.

& PuTTY Configuration

Category
= Session Options controling local seral lines
Logging Select 2 serilne
= Teminal
Keyboard Serial line to connect to com3
Tree view = B PRRET,
Features orfigure the serial line
= Window Speed (baud) 2600
;Deamnce Data bits 8
ishaviour
Translation Stop bits 1
Selection Paty
Colbia arity None
=-Connection Flow control XON/XOFF 5
Data
Proxy
Telnet
Rlogin
- S5H
Serial
Font

» From the tree view, select Connection > Serial and set the
parameters as needed. Ensure that the COM port that you specify
corresponds to the one that you wrote down at step 3c.

» If you want to view the characters that you type on screen, from the
tree view, select Terminal. Under Local echo, set the value to
Force on.

» From the tree view, select Session. Select Serial. The COM port
number and the speed should correspond to those that you have
previously entered.

4c. Tap Open. The unit is now ready to receive or send data.
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5. From the device, set the communications parameters.

IMPORTANT

To be able to establish a communication between the unit and the
device, you must set the following parameters to the same values
as those defined on your unit:

» Speed
Data bits
Stop bit
Parity

Y Y VYY

Flow control

Note: The COM port number that you set on your device will probably differ from
the one that you used on your unit.

6. From the device, establish communication with the unit using your
favorite communication tool (PuTTY, HyperTerminal, etc.).

140 FTB-1



FTB-1

Managing Data
Enabling or Disabling the Bluetooth and Wi-Fi Devices

Enabling or Disabling the Bluetooth and Wi-Fi
Devices

By default, both the Wi-Fi and Bluetooth devices are enabled on units that
are equipped with the corresponding options.

If you do not intend to transfer files via Bluetooth or to work with a wireless
network for a certain period of time, you may wish to disable the devices to
extend battery life.

As soon as you disable the Wi-Fi device, the Bluetooth is automatically
disabled as well.

You can enable the devices again at any time.

To enable or disable the Bluetooth and Wi-Fi devices:
1. From the Main Menu, tap Setup.

2. Double-tap Network Connections.

B Control Panel Q[E

Fle Edt View Toos Help "
¢ O [F| Pseaen Folders X ¥ m-

address @ Control Panel ~| B e

Fr—— 2 g ) A @ (&
4 Q & o IV | & &=

Administrative Battery Bluetooth  Date and Time Device Folder Options Fonts Internet Java Keyboard
Tools Calibration Devices Manager Options

H e @0 =2 9 & e

B

l_)

Mause

Power Options Frintersznd  Regionaland Stamnersand  Soundsand  User Accounts Windows
Fa Language . Cameras  Audio Devices Firewal
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3. Select Wireless Network Connection.

" Network Connections

Fle Edit View Tools Advanced Help

Q- Q ¥ /\JsEamh [ roes | [ 30 X &) -

Address |4} Network Connections

LAN or High-Speed Internet

Local Ares| Virreless
Connectio Network

Connection

Personal Area Hetwork

Blustoath
Network...

B 9

New Network Setup
Connecti... Wizard

4. From the File menu, select Enable or Disable, according to your

needs.
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Transferring Files with the USB Data Mover
Application

With the USB Data Mover application, you can copy folders and files from
your unit to a USB storage device quickly.

You can retrieve files from the predefined source folders or specify your
own folders.

The predefined folders are:

» My Documents, which path is D:|Documents and
Settings|User_currently logged onlMy Documents

where User _currently logged on corresponds to the user name of the
person that is currently logged on the unit.

» Shared Documents, which path is D:|Documents and
Settings|All Users\Shared Documents.

Note: You cannot remove the predefined folders from the list of source folders,
but you can remove the ones that you have added.

By default, the application retrieves the files from all the folders appearing

on the list of source folders. However, you can specify which folders you
want to take into account.
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Each time you copy data, the application creates a folder on the storage
device. This folder will contain the copied files and subfolders (original
folder structure as well as folder and file names are kept).

The application generates folder names as follows:
[YEAR]-[MONTH]-[DAY] [HOUR]-[MINUTE]-[SECOND]
Example:

For a copy operation requested on September 20, 2013, the folder name
could be:

2013-09-20-13_23-01-45.

Note: The HOUR value will appear in a 24-hour format, regardless of your unit's
time settings.

To transfer files with the USB Data Mover:

1. Connect a USB storage device to one of the USB ports.
2. From Mini Toolbox, select the Utilities tab.

3. Tap USB Data Mover.

T Mini ToolBox (G

3 E2 e

Bluetooth File EXFO Connect Client FTB-Care GPS Coordinates
Transfer Wizard Viewer

e B 3 & £ e

System Info

Internet Explorer Notepad Options Activation Product PUTTY
Registration

-

TightVNC Server Update Manager USB Data Mover VPH Installer WiFi Connect
Start

@ .l 11/13/2013 12:34PM
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4. Select or clear the check boxes to adjust the folder selection to your
needs.

olders;

[®] my Dpeuments

D Shargd Documents

lz‘ D:\Results Files - To transfer

Destination Media:

Press "Copy" button to copy the files to the destination media.

5. If necessary, under Destination media, select the desired USB storage
device.

6. Tap Copy. The files will remain on your unit after the transfer.

7. When you have finished, tap [} to exit the USB Data Mover
application.
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To manage the list of source folders:
1. From Mini Toolbox, select the Utilities tab.

2. Tap USB Data Mover.

T Mini ToolBox W&

Utilities Mini ToolBox %

S—
Bluetooth File Calculator EXFO Connect Client FTB-Care GPS Coordinates
Transfer Wizard Viewer
System Info
Internet Explorer Hotepad Options Activation Product PuTTY
Registration

\\.
y

o A | & (@

TightVNC Server Update Manager USB Data Mover VPN Installer WiFi Connect
Start

@ i 11/13/2013 12:34PM

3. Tap User Preferences.

Source Folders:

My Doruments

\:‘ Shared Documents
D \Results Files - To transfer

Docu.. psh
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4. If you want to add your own folders to the list of source folders,
proceed as follows:

4a. Tap Add a Folder.

| Add a Folder... | i Remave Folder

Close

4b. Select the desired folder, and then tap OK.

Browse For Folder

[E} Desktop -~
() My Documents
= 7§ My Compuker
e SYSTEM (C1)
= < APP (D)
I Documents and Settings
1) Prog i
= [
(3 control
() Shared Documents

— ]
Add a Fold
[(rsketien Foider | ([_ok_])_concel |
~ .:E
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5. Ifyouwant to remove folders from the list of source folders, proceed as
follows:

5a. Select the folder that you want to remove.

User Preferences

Add a Folder... | ‘ Remave Folder

Close

5b. Tap Remove Folder.

Note: The application will not prompt you to confirm the remouval of the folder
from the list.

6. When you have finished, tap Close. Your changes are reflected
automatically. All the newly added folders are selected by default.

7. Tap to exit the USB Data Mover application.
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Connecting to a VPN from Your Unit

Note: Only administrator-level users can install software under Windows
Embedded Standard. However, when the installation is complete, all users
will have the possibility to connect to a VPN from the unit.

You can connect to a Virtual Private Network (VPN) from your unit if you
install one of the supported VPN clients (applications). Such clients allow
you to connect to the VPN of your company from anywhere in the world
and have access to network resources as if your unit was connected locally
to the network. This could be useful if you need to transfer data to a
centralized folder on the company’s private network, for example.

To establish the communication between the VPN client and the VPN
server, you can use either a Wi-Fi connection (see Connecting to a
Wireless Network on page 131), a 3G USB modem key (see Accessing the
Internet with a 3G USB Modem Key on page 106), or a standard Ethernet
connection.

Note: Since all nefworks are different, the parameters that you need to configure
before being able to connect to the VPN may vary. For information on the

configuration specific to your network, contact your network administrator.

If you ever need to change to another VPN client or remove it, see Solving
Common Problems on page 195.
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IMPORTANT
EXFO does not provide any VPN clients. You must provide the
installation files for one of the supported VPN clients yourself. The
complete list is available from the VPN Installer application.

EXFO cannot guarantee that any VPN client other that those listed
will work properly on your unit.

To retrieve the list of supported VPN clients:
1. On your unit, from Mini ToolBox, select the Utilities tab.

2. Tap VPN Installer.

3. From the VPN Installer first window, tap Continue.

IMPORTANT:
To ensure the proper instaliaion of your VPN ciert, NEVER aftempt to install it menually
Hways usathe VPN Instaler

Before in: a VPN Client, you should close all Windows applications. Otherwise, you mi

g uid clos
experience 5 siower and unstablz installation

150 FTB-1



Managing Data
Connecting to a VPN from Your Unit

4. All the supported VPN clients appear on the Supported software and
versions list. You can write down this list and contact your network
administrator to get the installation files.

18 VPN Installer

EXFO doss not provids any VPN dlents
You can use any cliet lisied under “Supparted sofivare and versions”

1) Please capy the desired VPN cliert fles to your platfom.
2) Select the comesponding VPN ient in the list and tap Cortinue

Supported software and versions:

Check Pairt VPN E75.10

Cisca AnyConnect VPN Cliert 2.5
Cisca Systems VPH Client 5.0
Juriper Netwark Connect 7.1

LA

EXPEATISE REACHING OUT

5. Tap Cancel to close the VPN Installer.

You are ready to go to the procedure explaining how to install the VPN
client on your unit.
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CAUTION

a » To ensure the proper installation of your VPN client, NEVER
attempt to install it manually. Always use the VPN Installer.

» DO NOT restart your unit during the installation even if you are
prompted to do so. Otherwise, the VPN client will not be
installed properly. The EXFO VPN Installer will restart your unit
automatically to complete the installation. If you updated the
VPN client by mistake, see Solving Common Problems on
page 195.

» Your unit has been designed to work with specific versions of
VPN clients. NEVER UPDATE the VPN client manually and ensure
that the VPN server will not update the client either. Otherwise,
the VPN client may no longer work properly.

IMPORTANT

EXFO does not recommend to install more than one VPN client on a
single FTB-1 unit.

IMPORTANT

To avoid communication problems between the VPN client and the
VPN server, ensure that the date set on your unit corresponds to the
current date.
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To install a VPN client on your unit:

1. If the date on your unit does not correspond to the current date, modify
it (see Adjusting the Date, Time and Time Zone on page 80).

2. Retrieve the installation files on your unit as follows:
2a. On your unit, create a folder on the Windows desktop.

2b. Copy the installation files (from a USB key or a folder network) to
the newly created folder.

On your unit, from Mini ToolBox, select the Utilities tab.

Tap VPN Installer.

T Mini ToolBox

O 2 B G e

Bluetooth File Calculator EXFO Connect Client FTB-Care ‘GPS Coordinates
Transfer Wizard Viewer
e @l B « f
Internet Explorer Notepad ‘Options Activation Product PuTTY

Registration

e ' e @®)
g e = | - !
TightVNC Server Update Manager USB Data Mover VPN Installer WiFi Connect
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5. From the VPN Installer first window, read the information. When you

have finished, tap Continue.

72 VPN Installer

IMPORTANT:

To ensurs the properinstaliation of your VPN clirt. NEVER attemet to install t manualy
Aways use the VPN Insialer

Before instaling a VPN Cliert, you shauld close all Windaws applications. Gthenwise, you might
experience a slower and unstable installation

RN W

EXPERTISE REACHING DUT

From the Supported software and versions list, select the entry
corresponding to the VPN client for which you have retrieved
installation files at step 2.

18 VPN Installer

EXFO doss not provids any VPN dlets
You can use any client listed under ~Supperied sftware and versions”

1) Please capy the desied VPN dlient fis to your platform.
2} Selact the comsspanding VPN oliert in the st and tap Continus

Supported software and versions:
Check Paint VPN E75.10

Cisco AnyCannect VPN Client 2.5
Cisco Systems VPN Client 5.0
Juniper Netwark Cornect 7.1

EXPEATISE REACHING DUT

Tap Continue.
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7. From the VPN Installer, select the corresponding setup file using the
Browse button.

IMPORTANT

To avoid installation problems, ensure that the installation files are
available from the Windows desktop of your unit. Never use
installation files directly from a USB key.

To install the dlient applcation

1 Select the comespending setup fils using the Browss button
2Tepthe Install buttan

Instaliation fil= forthe WPN client:

Browse.

IMPORTANT-

EXFO does not recommend to install more than cne VPN 2=
dlient on a same unit

EXPERTISE

Help Cancel

Note: Depending on the VPN client that you have selected previously, you may
have two installation files to select (fwo Browse buttons instead of one).
For more information, refer to the online help provided with the VPN
Installer.
8. Tap the Install button.

9. Follow the on-screen instructions.

Your unit will restart automatically to complete the installation of the VPN
client. All users will now be able to connect to a VPN from the unit.
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To connect to a VPN from your unit:
Start the VPN client and follow the on-screen instructions.

If you are not sure about the information that you should provide, contact
your network administrator.
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9 Accessing Your Unit Remotely

You can access your unit remotely from a computer using either the
Remote Desktop Connection or TightVNC Client applications.

The table below presents the differences between the two applications.

Characteristic

Remote Desktop
Connection

TightVNC Client

Type of connection

Direct between the unit
and the computer; only
one user can be connected
to the unit at a time.

Not exclusive; several
users can be connected
to the unit at the same
time (sharing the same
session).

Windows user rights

Taken into account.

Not taken into account.

Password-protected

Yes; mandatory. The user
name and password are
the same as those used to
connect to the unit.

By default, all the accounts
with administrator rights
can use Remote Desktop
Connection. If you want
accounts with limited
rights to be able to use
Remote Desktop as well,
you must specifically grant
them access.

Yes; mandatory. The
password is defined on
the TightVNC Server, the
first time you start the
server. This password is
not related to the one
used to connect to the
unit. By default, all people
that use TightVNC Client
will enter the same
password (as defined on
the server).

Each user to whom you
provide the password will
be able to connect to the
unit via TightVNC.
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Working with Remote Desktop

By default, all the accounts with administrator rights can use Remote
Desktop. If you want accounts with limited rights to be able to use Remote
Desktop as well, you must specifically grant them access.

You can also configure the unit to prevent users from accessing it remotely.

Accessing Your Unit with Remote Desktop

To be able to connect to the unit using Remote Desktop, you must:

» Know the IP address of the unit and provide it in the connection
settings on the computer.

» Use an account that is secured by a password. Remote Desktop will
not allow any connection with empty passwords.

» Enter the appropriate user name when Remote Desktop application
prompts you. Usually, this user name must correspond to the user
name of the person currently logged on the unit. Otherwise, you will
disconnect the person that was already connected.
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To access your unit remotely with Remote Desktop:

1. Connect both the computer and your unit to the same network and
make sure they can “see” each other as network restrictions might
prevent them from communicating.

» If you want to use an Ethernet network, connect an RJ-45
(network) cable to the unit’s RJ-45 port located on its top panel.

» If youwant to use a wireless network, see Connecting to a Wireless
Network on page 131.

» You could also create a Private Area Network with your Bluetooth
device (contact your network administrator).

Turn on both the computer and the unit.

On your unit, in Mini Toolbox, go to Main Menu. Select System Info >
Platform.

4. Write down the IP address, and then close the window.
Note: It may take a few seconds before you see the IP address on the list.

5. From the computer, on the taskbar, click Start, then select
All Programs > Accessories > Remote Desktop Connection.
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6.

9.

In the Connecting to Remote Desktop window, in the Computer list,
type the IP address of the unit that you wrote down at step 4.

“8 Remote Desktop Connection

Compuer: | 172162076 v

[_connect [ cancel | [ Hep | [ Options >

Click Connect.

When the application prompts you, enter your user name and
password.

Log On to Windows

Username: | My New User

T o

[ [ Cancel ] [Oplmns ey ]

Click OK to open the session.

Allowing Users with Limited Accounts to Use
Remote Desktop

By default, only the accounts with administrator rights can use Remote
Desktop. However, you can assign extra user rights to accounts with
limited rights so that they can also use Remote Desktop.
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To allow a user with limited accounts to use Remote Desktop:
1. On your unit, from the Main Menu, select System Settings.

2. From System Settings, tap Remote Session.

System Settings
Display and Sound
Backlight
R ]
Volume
-
4
D Mute ‘ Audio Mixer... ‘ ‘ Sound Options... |

3. Ensure that Allow remote connections to this unit (from computer
using Remote Desktop client application) is selected.

System Settings

Remote Session
Startup
E Start TightVNC Server automatically at unit startup

Remote desktop

() Do not allow remote connections to this unit

(@) Allow remote connection to this unit °
(from computer using Remote Desktop client application) Remote Session

Select users that are allovwed to connect to this unit using Remote Desktop:

D Guest

D Operator

M| 4| > |pr[D

4. From the list of users, select the boxes corresponding to the users to
whom you want to grant access.

5. Tap [&] to return to the Mini Toolbox window.
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Preventing Users from Connecting with Remote
Desktop

You can also configure the unit to prevent users to access it using Remote
Desktop. However, all users having administrator user rights will be able to
modify this setting at any time.

To prevent users from connecting to the unit using Remote
Desktop:

1.
2.

On your unit, from the Main Menu, select System Settings.

From System Settings, tap Remote Session.

B2 System Settings

Display and Sound
Backlight

Volume

J

Select the Do not allow remote connections to this unit option.

D Mute ‘ Audio Mixer... Sound Options... |

B2 System Settings

Remote Session
Startup
E Start TightVNC Server automatically at unit startup

Remote deckiop

) Automati

Startup Applications

(@ Do not allow remote connections to this unit

() Allow remote connection to this unit

(frem computer using Remote Desktop client application) Remote Session

CIRNIRE AL

Tap g} to return to the Mini Toolbox window.
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Restarting or Turning Off Your Unit While Working
with Remote Desktop

In some cases, you may need to restart or shutdown your unit while you
are controlling it remotely.

To restart or turn off your unit with Remote Desktop:

1. Close all applications, including Mini Toolbox.

2. On the taskbar, click Start, then select Run.

3. If you want to restart your unit, in the Open box, enter Shutdown -r.
OR

If you want to turn off your unit, in the Open box, enter Shutdown -s.

= Type the name of a program, Folder, document, or
Internet resource, and Windows will open it for you,

open: | Shutdown -r| v

I Ok l [ Cancel ] [ Browse,..
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Working With TightVNC

The control of your unit with TightVNC requires the TightVNC Server
(already installed on your unit) and the TightVNC Client Viewer (that you
must install on your computer).

The first time you start the TightVNC Server on your unit, the application
will prompt you to define passwords. Once these passwords are defined,
you are now ready to connect to your unit using the TightVNC Client (on
your computer).

If you want TightVNC Server to start automatically when you turn on your
unit, see Configuring TightVNC Server to Start Automatically on page 171.

IMPORTANT

u The passwords that you set for the application that is started
automatically are independent of the passwords that you set for

the application that you start manually (via the Utilities tab). This
means that you could need to enter different passwords,
depending on which TightVNC application you use to connect to
your unit.

If you do not want to manage two different sets of passwords, you
can set all passwords to the same value.

164 FTB-1



Accessing Your Unit Remotely
Working With TightVNC

CAUTION

Be very careful if you use TightVNC to transfer files between a
computer and your unit (TightVNC Server).

» Transfer from a computer to your unit: If the transfer is
interrupted, all files on your unit having the same name as
those on the computer WILL BE DELETED. However, the files on
the computer will remain available.

» Transfer from your unit to a computer: If the transfer is
interrupted, all files on the computer having the same name as
those on your unit WILL BE DELETED. However, the files on your
unit will remain available.

To be able to connect to the unit using TightVNC, you must:

» Know the IP address of the unit and provide it in the connection
settings on the computer.

» Know the password (same for all users by default).

This section provides you with the basic information to control your unit
with TightVNC. For more information, refer to the TightVNC online help.
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Configuring the TightVNC Server

The TightVNC Server is already installed on your unit. You must configure
passwords before establishing a connection between a computer and your

unit.

To configure the TightVNC Server:

1. Ifyou have configured TightVNC Server to start automatically when you
turn on your unit, go directly to step 2. Otherwise, from Mini Toolbox,
select the Utilities tab, then tap TightVNC Server Start.

T Mini ToolBox

Utilities

3

Transfer Wizard

e B

- &

Bluetooth File Calculator EXFO Connect Client

Internet Explorer Hotepad Options Activation

TightVNC Server Update Manager USB Data Mover
Start

FTB-Care GPS Coordinates
Viewer

Prodi IICF PuTTY
()

VPN Installer 'WiFi Connect

2. Select the Server tab.
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3. Inthe Primary password and View-only password boxes, type the
desired passwords.

Tight¥NC Server: Current User Properties F|§‘

Server | Hooks | Display | Query | Administration

Incaming connectians Display or port numbers ta use

Primary password: | TTXX0003 OPart
orts:

View-only passiord. [esssssse

[ [/l &ccent socket @ buto (O Display:

Imput handing \wher last client disconnects
[ Block remate input svents (& Da nathing
[]Block remate input on local activity O Lock workstation

) Logolf workstation

[] Mo local input during client sessions
Enable fil tiansfers

Fiemove desktop walpaper

[ Blank scieen an client connections

ok ][ cencel ][ Apew

Note: The two passwords are independent of each other. They do not have to be
identical.

4. Tap Apply, and then OK.
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Note:

Installing the TightVNC Viewer on a Client
Computer

If the TightVNC Viewer is not already installed on your computer, you can
install it with the DVD that came with your FTB-1.

To install the TightVNC Viewer on your computer:

1.

2
3.
4

Insert the installation DVD into the CD/DVD drive of your computer.
From the DVD Main Menu, click Explore this DVD.
Open the Utilities folder, and then copy the VNC Client folder.

Paste the VNC Client folder to a location of your choice on your
computer.

You are now ready to start working with the TightVNC Viewer.

If you want to access the TightVNC Viewer without having to install it on
your computer, you can start it from the DVD (Main Menu > Utilities >
VNC Client)
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Connecting to Your Unit with TightVNC

Once the TightVNC Viewer is installed on your computer, you are ready to
access your unit remotely.

To connect to your unit with TightVNC:

1. Connect both the computer and your unit to the same network and
make sure they can “see” each other as network restrictions might
prevent them from communicating.

» If you want to use an Ethernet network, connect an RJ-45
(network) cable to the unit’s RJ-45 port located on its top panel.

» If youwant to use a wireless network, see Connecting to a Wireless
Network on page 131.

» You can also create a Private Area Network with your Bluetooth
device (see Transferring Data via Bluetooth on page 124).

Turn on both the computer and the unit.

On your unit, in Mini Toolbox, go to Main Menu. Select System Info >
Platform.

4. Write down the IP address, and then close the window.

Note: It may take a few seconds before you see the IP address on the list.
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5. Ifyou have configured TightVNC Server to start automatically when you
turn on your unit, go directly to step 6. Otherwise, from Mini Toolbox,
select the Utilities tab, then tap TightVNC Server Start.

T Mini ToolBox

Utilities

9 B
o]
foett

Bluetooth File Calculator EXFO Connect Client
Transfer Wizard
Internet Explorer totepad Options Activation

TightVNC Server Update Manager USB Data Mover
Start

FTB-Care

-

Product
Registration

A
i

VPN Installer

GPS Coordinates
Viewer

ES

PUTTY

(.(U))'

'WiFi Connect

EEX

Mini ToolBox Ei
L

6. From your computer, double-click the TightVNC Viewer shortcut on

your desktop.

7. Inthe VNC Server list, type the IP address of your unit that you wrote

down at step 4.

New TightyNC Connection HE
YN server: ([ITENEEIER ~]) | [ comeat |
Connection prafle———————————— Optians...
w " Lowbandwidth connection

:C " Default connection options Caneel

" Highrspeed netwaork

Listering o |

8. C(lick Connect.
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Configuring TightVNC Server to Start
Automatically

Note: Only administrator-level users can configure the TightVNC Server to start
automatically.

By default, the TightVNC Server is not started automatically when you turn
on your unit. However, you can modify this setting. This is especially useful
if you need to remotely connect to your unit without having the unit close
at hand. To benefit from all the advantages of this feature, you may also
want to enable the automatic logon (see Enabling or Disabling the
Automatic Logon on page 62). Otherwise, you will need to manually
connect to a user account before the TightVNC Server could be started.

IMPORTANT

u The passwords that you set for the application that is started
automatically are independent of the passwords that you set for

the application that you start manually (via the Utilities tab). This
means that you could need to enter different passwords,
depending on which TightVNC application you use to connect to
your unit.

If you do not want to manage two different sets of passwords, you
can set all passwords to the same value.
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Configuring TightVNC Server to Start Automatically

To configure TightVNC server to start automatically:
1. On your unit, from the Main Menu, select System Settings.

2. Tap Remote Session.

B2 System Settings
Display and Sound
Backlight
|
Volume
-
v
D Mute ‘ Audio Mixer... ‘ ‘ Sound Options... |

box.

B2 System Settings

emote Session
Startup
E Start TightVNC Server automatically at unit startup

Remote deskiop

() Do not allow remote connections to this unit

(@) Allow remote connection to this unit

(from computer using Remote Desktop client application) Remote Session

Select users that are allowed to connect to this unit using Remote Desktop:

|:| Guest

|:| Operator

M[dd| 4| > |pp|H

4. When the unit prompts you, tap Yes to configure the TightVNC
passwords (and other parameters) if necessary.

The new parameters are now taken into account. For more information on
how to connect to your unit, see Connecting to Your Unit with TightVNC on
page 169.

5. Tap €] to return to the Mini Toolbox window.
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Accessing Your Unit Remotely

Adding Exceptions to the Firewall

Adding Exceptions to the Firewall

Note: Only administrator-level users can add exceptions to the firewall.

Your unit is protected by the Microsoft firewall to prevent unauthorized
access when it is connected to a network or to the Internet. The firewall
has been preconfigured so that all the applications that come with your
unit work properly. However, you can allow other applications to access
the network or the Internet by adding exceptions.

If you are not sure about how to configure the firewall, contact your
network administrator.

To add exceptions to the firewall:

1.
2.

On your unit, from the Main Menu, tap Setup.

Double-tap Windows Firewall.

B Control Panel g@l
Fle Edt View Toos Hei -
€) D ¥ O searen Folders X ¥ @&
Adciress |[@ Control Panel b €J
ey L 3 =3 y A ’ y
Administrative Battery Bluetooth  Date and Time Device Folder Options Fonts Internet Java Keyboard
Tods  Calbration  Devices Manager Options
. @ \ P = p
Hh @ 4 L e 2 9 =

Mouse

Connections Faxes  Langusge ...

Metwork  Power Gptons Printersand  Regionaland  Scamnersand  Soundsand  User Accounts|
Cameras  Audio Devices
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Adding Exceptions to the Firewall

3. Select the Exceptions tab.

%= Windows Firewall

Windows Frewal Tt Blocking incoming network connections, sxcept forthe
programs and services selected below. Adding exceptions allows some programs
to work better but might increass your securty nsk

Programs and Services:

Name:

=n Printer Snaring

Zlla Server

if Java)

intenance Service
ssage Queung
FluginTestApp
CIFNRP

Remete Deskicp

I UPAP Framework
MVIT Meria Plaver

[(Add Program... | [ AddPot.. [ Eat ] [ Delete

[ Display = natiication when Windows Firewall blacks a program

What are the risks of allowing exceptions?

Tap Add Program to add any application that you need.

When you have finished, tap OK (located at the bottom of the dialog
box) to confirm the changes and return to the Control Panel window.
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10 Testing Network Connections

Note: This function is available with the optional IPT software package only.

FTB-1

The two most common basic tests widely used in networking are the
ping test and the frace route test. With these tests, you can ensure that IP
packets travel as expected from a local host to a remote host and vice
versa.

IMPORTANT

u To avoid misleading results, always ensure that your unit is only
connected to one network at a time (either standard Ethernet or

wireless network) before performing ping or trace route tests.

Performing a Ping Test

The ping test is a basic test that measures the average time it takes for a
packet to reach the remote host. With this test, you can quickly verify that
the remote host functions properly.

The ping test has six common parameters:

>

Y Y VYY

>

The URL (IP address)

The number of packets to send

The packet size

The maximum time allowed for a packet to reach the remote host

The maximum number of hops allowed for reaching the remote host
(TTL)

A flag to indicate whether a packet can be fragmented.

When the test is complete, you can export the results. You can later import
the generated text file (tab-delimited) directly into Microsoft Excel.
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Performing a Ping Test
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To perform a ping test:

1.

From Mini Toolbox, select the Test Tools tab, then tap IP Tools.

T Mini ToolBox

Modules | Utilitie; SEESGHE

0 2 2R 2 &

ExpertIP Test Tools  EXpert IPTV Test EXpert VoIP Test 1P Tools jPerf
Tools Tools
(((A{ ,))) i
Hetwork Stumbler  OTDR Bidirectional wireshark

O ff 11/13/2013 10:41AM

From IP Testing Tools, select the Ping tab.
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Testing Network Connections

Performing a Ping Test

3. Enter a URL or an IP address to reach. You can tap the Default button

to use the unit's default ping address. The default value cannot be

configured.

|

Results
# TIL
(hops)

RTT
(ms)

From

Statistics
Fackets
Sent:

Received:

Lost:

Time (ms)
Min.:
Max.:
Average:

1P Testing Tools

Start

Main Menu

Export

About

URL or IP address:

Default

ome [] 1 7]
(=[]
Timeout (ms): B 1000

[ o= [-]

E Allow fragmentation

Packets size (bytes):

Time ta live thops):

4. Set the other parameters:

» Number of packets to send
Packet size
Timeout limit

TTL limit

YyYYyYVvYYy

complete packets to the host.

5. Tap the Start button.

You can stop a ping test at any time by tapping the Stop button.

Clear the Allow fragmentation check box if you prefer sending
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Performing a Trace Route Test

Performing a Trace Route Test

The trace route test is used to evaluate the average number of nodes that
are required to reach the final host. It is often used to troubleshoot
networks (identify accesses blocked by firewalls or routing problems).

This trace route test utility enables you to:
» Enter a remote host address.
» Set the maximum time allowed for a packet to reach the remote host.

» Set the maximum number of hops allowed for reaching the remote
host (TTL).

» Choose whether to resolve DNS for the IP address or not.

When the test is complete, you can export the results. You can later import
the generated text file (tab-delimited) directly into Microsoft Excel.
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To perform a trace route test:

Testing Network Connections

Performing a Trace Route Test

1. From IP Testing Tools, select the Trace Route tab.

2. Enter an URL or an IP address to reach. You can tap the Default button
to use the unit's default trace route address. The default value cannot

be configured.

IP Testing Tools

Start

Main Menu

Export

About

Results
Hop ATTIms  ATTI(ms)  ATT(ms IP Address Domain Name
< >
Statistics
Packets
Sent: [a}
Received: 1}
Lost: [a} Final IP address: 0.0.0.0
URL or TP address: Default
Timeaut {ms); B 1000
e I

[3¢] Resolve [P addresses

3. Set the other parameters:
» Timeout limit

» TTL limit

» Select or clear the Resolve IP addresses check box if you want to
get the host name for the corresponding IP address of nodes.

4. Tap the Start button.

You can stop a trace route test at any time by tapping the Stop button.
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Exporting the Results

Exporting the Results

When a test is complete, you can export the results of the current test
page. If you want to keep your results for future use, you must export them
because result files cannot be opened directly from your unit.

Results are sent to a text file. Fields are separated by the “TAB” character to
simplify the importation into a Microsoft Excel worksheet.

By default, the application suggests a file name:
» For ping tests:

Ping for [URL] on [YEAR] [MONTH]_[DAY].txt
» For trace route tests:

Trace Route for [URL] on [YEAR] [MONTH]_[DAY].txt
Where:

» [URL] is the entered URL or IP address,

» [YEAR] is the year of the test,

» [MONTH] is the month of the test,

» [DAY] is the day of the test.
Example:

For a ping test at www.yoursite.org made on January 3 2010, the
suggested filename would be:

Ping for www.yoursite.org on 2010_01_03.txt

To export results:
Tap the Export button. If necessary, modify the suggested file name.
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11 Maintenance

To help ensure long, trouble-free operation:

FTB-1

>

>

Always inspect fiber-optic connectors before using them and clean
them if necessary.

Keep the unit free of dust.

Clean the unit casing and front panel with a cloth slightly dampened
with water.

Store unit at room temperature in a clean and dry area. Keep the unit
out of direct sunlight.

Avoid high humidity or significant temperature fluctuations.
Avoid unnecessary shocks and vibrations.

If any liquids are spilled on or into the unit, turn off the power
immediately, disconnect from any external power source, remove the
batteries and let the unit dry completely.

WARNING

The use of controls, adjustments and procedures, namely for
operation and maintenance, other than those specified herein may
result in hazardous radiation exposure or impair the protection
provided by this unit.
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Maintenance

Cleaning Detector Ports

Cleaning Detector Ports

Regular cleaning of detectors will help maintain measurement accuracy.

IMPORTANT
Always cover detectors with protective caps when unit is not in use.

To clean detector ports:
1. Remove the protective cap and adapter (FOA) from the detector.

2. If the detector is dusty, blow dry with compressed air.

3. Being careful not to touch the soft end of the swab, moisten a cleaning
tip with only one drop of isopropyl alcohol.

IMPORTANT

u Alcohol may leave traces if used abundantly. Do not use bottles that
distribute too much alcohol at a time.

4. While applying light pressure (to avoid breaking the detector window),
gently rotate the cleaning tip on the detector window.

Repeat step 4 with a dry cleaning tip or blow dry with compressed air.

Discard the cleaning tips after one use.
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Cleaning the Touchscreen of Your FTB-1 Unit

Cleaning the Touchscreen of Your FTB-1 Unit

Clean the touchscreen with a soft, non-abrasive cloth, such as one used for
cleaning reading glasses, dampened with water.

CAUTION
Using anything else than water can damage the special coating of

the touchscreen.

Recharging the Main Battery

The main lithium-ion battery is offered in two sizes:

» A four-cell (small) battery

» An eight-cell (large) battery

The clock battery is recharged automatically along with the main battery.
» In Mini Toolbox, the charge status is shown above Main Menu.

» The unit also indicates the charge status with the LED on its front panel
(see LED Indicators Description on page 5):

Status LED Battery Charge Status
Green Fully charged
Green, blinking Charging
Red Error or battery is not in the unit

CAUTION
Only charge the battery with the AC adapter/charger (or the car

outlet adapter) provided by EXFO with your unit.

FTB-1 183



Maintenance
Recharging the Main Battery

184

u’

IMPORTANT

Batteries are not charged at the factory. Install the battery
compartment on your unit (see Replacing Batteries on

page 188), and then fully charge the battery before using the
unit for the first time. The battery is fully charged after a few
hours or when the battery LED indicator stops flashing.

The time required to charge batteries depends on various
factors such as the type of modules currently in use and the
ambient temperature.

To ensure that batteries function or charge properly, keep them
in temperatures between 10 °C and 40 °C (50 °F and 104 °F).
Store below 50 °C (122 °F).

Depending on the way the unit is used, after a while, the charge
status icon may no longer correspond to the actual power level
of the battery (for example, icon indicates that power level is
sufficient, but unit turns off because battery is too weak). A
complete calibration cycle will be necessary (see Recalibrating
the Battery on page 185).

To recharge the main battery:

Connect the unit to a power outlet using the AC adapter/charger. The
charge cycle will start and end automatically.
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Recalibrating the Battery

Recalibrating the Battery

Depending on the way the unit is used, after a while, the charge status icon
may no longer correspond to the actual power level of the battery (for
example, the battery level icon indicates that power level is sufficient, but
unit turns off because battery is too weak). A complete calibration cycle
will be necessary.

IMPORTANT

u When the estimate offset value (displayed in the battery calibration
application) is of 10 % or more, EXFO recommends that you
recalibrate the battery.

You can perform a recalibration with the battery calibration utility:
» The utility will charge the battery until it is full.

» It will then discharge the battery completely.

» You will have to let the battery recharge completely.

The whole calibration process can take several hours. You can stop the
process at any time, but the battery will still need calibration and the
battery will not necessarily be full (depending on the moment at which you
stop the process).

When a calibration step is underway, the LED preceding the step name
appears in yellow. When a step is complete, the LED turns to green.

FTB-1 185



Maintenance
Recalibrating the Battery

To recalibrate the batteries:

1. From the Main Menu, select Setup, and then double-tap Battery
Calibration.

Power status

AC power
Charger activity
Battery

Battery level:
Estimated offset:

Calibration

2. Connect the AC adapter/charger to your unit.
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Maintenance
Recalibrating the Battery

Tap the Start Calibration button (the Stop Calibration button will
become available).

Once calibration is complete, the Start Calibration button becomes
available again.

Power status

AC power
Charger activity
Battery

Battery level:
Estimated offset:

Calibration

Stop Calibration

WARNING !

This operation may take several hours to complete.

Pleasa, do not disconnect the AC power until the operation is mmplete
Do not turn off the device during the calibration process.
Avoid using the device during the calibration process.
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Replacing Batteries

Replacing Batteries

Your unit uses batteries with built-in protection that have been especially
designed for EXFO. For this reason, you can only replace the main battery
with a battery designed for your FTB-1.

You can purchase new batteries and empty battery compartments (also
known as “battery covers”) from EXFO.

The main lithium-ion battery is offered in two sizes:
» A four-cell (small) battery
» An eight-cell (large) battery

Note: Since the battery must fit in the battery compartment, these compartments
are also offered in two sizes.

Note: Batteries and battery compartments are sold separately, which means you
can purchase extra batteries to use with a battery compartment that you
already have. The size of the battery must match the size of the
compartment.

CAUTION

Use Li-lon batteries of the same type and model only. Use of other
batteries may damage your unit and compromise your safety.

WARNING

Do not throw batteries into fire or water and do not short-circuit
the battery’s electrical contacts. Do not disassemble.

To remove the main battery:
1. Turn off the unit.

2. Remove the battery compartment (located next to the module) as
follows:
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Replacing Batteries

2a. Position the unit so that its front panel rests on a flat surface such
as a table.

2b. Lift the mobile part of the battery compartment screws and turn
the screws counterclockwise until the compartment is loose.
Since they are captive screws, you cannot remove them
completely.

Turn screws
counterclockwise

Battery compartment

CAUTION

Shocks and drops may have loosened the battery inside its
compartment.

To avoid irremediable damage to the battery, always remove the
battery compartment carefully, ensuring that the battery does not
fall.

2c. Hold the battery compartment by its sides and pull it up carefully.
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Replacing Batteries

3. If necessary, release the battery from its compartment as follows:

3a. Position the battery compartment so that the battery is facing you.
3b. Pull on the battery tab to free the battery from its socket.

You are now ready to replace the battery.

To replace (or install) the main battery:

1. If you do not have a replacement battery, contact EXFO to purchase a

new one.
2. Position the battery compartment so that you can view its hollow part.

IMPORTANT

Always use a battery whose size corresponds to the size of the
battery compartment.

190 FTB-1



Maintenance

Replacing Batteries

3. Install the battery as follows:

3a. Insert the new battery, respecting the polarity. You can use the
image appearing inside the compartment as a guide.

| |

L

——Battery poles

Note: When the battery is correctly positioned, its poles should be facing upwards
and be placed on the same side as shown on the illustration in the battery
compartment.

3b. Apply slight pressure to the battery to secure it in place.

Position the battery compartment so that you can see the two screws.

Place the battery compartment on the platform, making sure that the
bumpers and the shorter sides of the compartment are flush with those
of the platform. If necessary, slightly move the battery compartment
until alignment is correct.

6. Lift the mobile part of the compartment screws and, while applying
slight pressure, turn the screws clockwise until they are tightened.

Note: You cannot replace the clock battery yourself.
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Recalibrating the Unit

EXFO manufacturing and service center calibrations are based on the
ISO/IEC 17025 standard (General Requirements for the Competence of
Testing and Calibration Laboratories). This standard states that calibration
documents must not contain a calibration interval and that the user is
responsible for determining the re-calibration date according to the actual
use of the instrument.

The validity of specifications depends on operating conditions. For
example, the calibration validity period can be longer or shorter depending
on the intensity of use, environmental conditions and unit maintenance, as
well as the specific requirements for your application. All of these elements
must be taken into consideration when determining the appropriate
calibration interval of this particular EXFO unit.

Under normal use, the recommended interval for your FTB-1 is: one year.

For newly delivered units, EXFO has determined that the storage of this
product for up to six months between calibration and shipment does not
affect its performance (EXFO Policy PL-03).
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Note:

Maintenance
Recycling and Disposal (Applies to European Union Only)

To help you with calibration follow-up, EXFO provides a special calibration
label that complies with the ISO/IEC 17025 standard and indicates the unit
calibration date and provides space to indicate the due date. Unless you
have already established a specific calibration interval based on your own
empirical data and requirements, EXFO would recommend that the next
calibration date be established according to the following equation:

Next calibration date = Date of first usage (if less than six months
after the calibration date) + Recommended calibration period (one
year)

To ensure that your unit conforms to the published specifications,
calibration may be carried out at an EXFO service center or, depending on
the product, at one of EXFO'’s certified service centers. Calibrations at
EXFO are performed using standards traceable to national metrology
institutes.

You may have purchased a FlexCare plan that covers calibrations. See the
Service and Repairs section of this user docurmentation for more
information on how to contact the service centers and to see if your plan
qualifies.

Recycling and Disposal
(Applies to European Union Only)

For complete recycling/disposal information as per European Directive
WEEE 2012/19/UE, visit the EXFO Web site at www.exfo.com/recycle.
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12 Troubleshooting

Solving Common Problems

Problem

Cause

Solution

Unit does not turn on.

Battery is discharged.

Charge the battery.

Replace the battery with a fully
charged one.

Connect the unit to an external
power supply using the AC
adapter/charger.

Unit is not connected
to an external power

supply.

Connect the unit to an external power
supply using the AC adapter/charger.

External power supply
is disconnected.

Make sure the external power supply
is connected at both ends.

Unit screen
is dark.

Unit’s backlight is off.

Press the backlight button.

Battery is discharged
and unit has shut
down.

>
>

Charge the battery.

Replace the battery with a fully
charged one.

Connect the unit to an external
power supply using the AC
adapter/charger.

>

At logon, no scroll bar is
displayed to browse
through all user
accounts.

Select any of the user accounts that
you can see on screen, and then
press the down arrow (from the unit’s
keypad) to go to the next account.

Use the up/down arrows to browse
through the accounts.

FTB-1
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Solving Common Problems

Problem

Cause

Solution

The System Settings
window is not displayed
correctly when you
control the unit via
Remote Desktop.

» Ensure that the System Settings
window is closed before you
connect to the unit with Remote
Desktop.

OR

» If you are already connected to
the unit with Remote Desktop,
close the System Settings
window, and then reopen it.

Some applications are
not displayed correctly
when you connect to
the unit with Remote
Desktop.

On your computer, the
screen resolution that
has been selected at
the time of connection
is too high.

On your computer, select a lower
screen resolution in the Remote
Desktop options before connecting to
your unit.

External keyboard is not
working.

External keyboard has
not been detected.

» Disconnect the keyboard, and
then connect it again.

» Turn off the unit, connect the
keyboard, and turn on the unit.

Screen characters are
dim.

Brightness is not set
propetly.

Adjust brightness.

Module is not detected.

The module’s
application has not
been installed yet on
your unit or the
module’s application
is not up-to-date.

Ensure that the latest version for your
module’s application is available on
your unit (see the Installing or
Upgrading the Applications section).
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Solving Cormnmon Problems

Problem

Cause

Solution

One of the applications
is not responding.

Press ¢1y and hold it down until the
shutdown menu appears, then select
Turn off. Turn the unit on again to
reset it.

Impossible to calibrate
the touchscreen via the
calibration application
in System Settings.

Screen calibration is
very poor.

» Press ¢Iy and hold it down until
the shutdown menu appears,
then select Turn off.

» Turn on the unit.

While the system is displaying the
boot menu (3 seconds), press the
down arrow from the unit’s
keypad to select the emergency
system tools operation mode.

OR

Press the ARROW DOWN key on
the keyboard (if you have
connected one).

» Press &/ from the
unit’s keypad or ENTER on your
keyboard to confirm your choice.

» Press % to start the
screen calibration.

Unit’s operating time is
reduced.

Battery is probably
worn out.

Replace the battery.

Battery was not fully
charged.

» Charge the battery.

» Perform a complete battery
calibration cycle?.

Battery indicator
remains low after a full
charge.

Battery is not
completely charged.

Perform a complete battery
calibration cycle?.

FTB-1
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Problem

Cause

Solution

Batteries are not

Ambient temperature

Ensure that the temperature in the

or hibernation mode
unexpectedly.

not defined correctly.

charging. is too high or too low. |location where you charge the
batteries is within the specifications.
AC adapter/charger is |Ensure that the adapter/charger is
not connected connected both to your unit and the
propetrly. power outlet.
Unit switches to standby |Power schemes are Select one of the predefined power

schemes (Always On or Max Battery).
For more information, see the
Configuring the Power Management
Options section.

Unit is not responding.

If you were not trying to install a VPN
client and your unit stopped
responding, restore your unit.

To do so, see the Restoring Your Unit
to Normal Operation section.

If you were trying to install a VPN
client, restart your unit and start a
new installation. If the problem
persists, restore your unit.
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Solving Cormnmon Problems

Problem Cause Solution
The 3G USB modem key |» There is no SIM Insert the SIM card into the USB
is connected, but you card in the USB modem key. For complete
are not able to access modem key. instructions, refer to the
the Internet. documentation that came with your

modem key.

» The FTB-1 unitis |Ensure that the latest System Upgrade

not up to date. and Platform kits are installed on your
unit before connecting your USB
modem key. For more information,
see the Accessing the Internet with a
3G USB Modem Key section.

» The USB modem |Disconnect the modem key from your
key is not detected |unit, and try connecting it again.

properly. If the modem key is still not detected,
try connecting it to another USB port.

» The SIM card has |Contact your provider of mobile
not been activated |services.
or there is a
problem with
service package
that you
purchased.

» The SIM card is
locked.

» There is a problem
with the mobile
network.

The GPS USB key is not Disconnect the GPS key from your
detected. unit, and try connecting it again.

If the GPS key is still not detected, try
connecting it to another USB port.
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Problem Cause Solution
Problems or errors Restart your unit and start a new
occurred during the installation. If the problem persists,
installation of the VPN restore your unit. To do so, see the
client. Restoring Your Unit to Normal

Operation section.

You want to change your Restore your unit. To do so, see the

VPN client for another Restoring Your Unit to Normal
client. Operation section.
OR

You need to remove the
VPN client from your
unit.

The VPN client has been |--- Restore your unit. To do so, see the
updated accidentally. Restoring Your Unit to Normal
Operation section.

a. A complete battery calibration cycle consists of a full charge, immediately followed by a full discharge,
then followed by a full charge.
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Restoring Your Unit to Normal Operation

Restoring Your Unit to Normal Operation

Your FTB-1 is set to start using the standard Windows startup sequence.
However, you can also use the emergency system tools feature if you need
to:

» check the disk integrity

» back up some files directly onto a USB storage device for recovery
purposes

» revert your unit to its initial state (as it was when you purchased it) or
restore it with a specific Windows image (WIM) that could have been
provided to you by EXFO customer service, for example.

IMPORTANT
The restoration of the system partition cannot be undone or

stopped once it is started.

If you have installed other products that are not included in your
image file, you will have to reinstall them afterwards.

To avoid loosing the data that is stored on the D drive, you may
want to back it up before restoring the system partition. Otherwise,
all your files will be lost.

Note: You may find useful to connect a keyboard and a mouse to your unit before
using the emergency system tools.
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Restoring Your Unit to Normal Operation

To navigate in the various windows using the unit’s keypad:

>
>

>

Use up/down and left/right arrows.

You can also press E,: to go to the next group of features (equivalent
of the TAB key).

Press £/ to select an item (equivalent of the ENTER key).

To restore the system partition:

1.
2.

Turn on the FTB-1.
While the system is displaying the boot menu (3 seconds), press

the down arrow from the unit’s keypad to select the Maintenance and
recovery mode.

OR

Press the ARROW DOWN key on the keyboard (if you have connected
one).

Press £/ from the unit’s keypad or ENTER on your keyboard to
confirm your choice.

Note: The touchscreen becomes effective at this point.

202

FTB-1



FTB-1

Troubleshooting
Restoring Your Unit to Normal Operation

4. From the main window, select Restore system partition from an

image, then tap Next.

% Emergency System Tools

Welcome to Emergency System Tools!
Select the desired action to perform in order to repair your damaged system cisk.
Click Next ta corkinue.

(®)Restore system partition from an image;
This action will rebuild your system as it was when it was shipped from the
factary. You should reinstal vour product packs and updates. The image fle
is located on the unit hard disk or on a USE device,

(O Backup data and configuration files to USB flash drive

This action will sllow yau to select Folders and Files in arder ta copy them ta a
USE writable device (typicaly a lash drive),

(O Check disk integrity
This action uses CHKDSK command-ine wtilly ko check for the hard disk.
integrity and repair it when needed.

Note :

Ta calibrate the tauch screen, press the Fallawing button on the platform:

m]

Next >

[ Restart |

If you want to revert your unit to its initial state (most cases), select

Factory recovery image.

OR

If you prefer to use an image file (provided by customer service, for

example), select .wim file and us

L Emergency System Tools
Restore system partition from image

Use the deFault image on dick. or brawse and select anather imags file.
Click. "Wext" ko continue.

select " wim file”, click "Browse...", and then salect anather image file.
() Factory recovery image

@ i Fle

Image Location

ExhToolbom: WIM 1,21,0.1.wim

Emergency System Tools use a defadlk image file on the disk. To choose a different location,

e the Browse button to locate the file.

X

3

Browse.., |

<gack | [ met

Cancel
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Troubleshooting

Restoring Your Unit to Normal Operation

6. Tap Next to proceed to the next step.

Restore system partition from image
Flease make sure that you really want to perform the recovery action.

Q WARNING!

This operation will erase the entire system partition and reinstal the factory system image.

IF you have installed new software, product packs and updates, you wil have to reinstall
them allin order to use them again.

This aperation cannat be stapped or undane.

The system wil reboat automatically after the operatian.

Press "Next” to continue.

< Back i [lext > | Cancel

7. Tap Next to start the restoration process. The unit will restart upon
completion of the process.
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Troubleshooting

Restoring Your Unit to Normal Operation

To retrieve data from the D drive:
1. Turn on the FTB-1.
2. While the system is displaying the boot menu (3 seconds), press

the down arrow from the unit’s keypad to select the Maintenance and
recovery mode.

OR

Press the ARROW DOWN key on the keyboard (if you have connected
one).

3. Press \/ from the unit’s keypad or ENTER on your keyboard to
confirm your choice.

Note: The touchscreen becomes effective at this point.

4. From the main window, select Backup data and configuration files
to USB flash drive, then tap Next.

% Emergency System Tools

Welcome to Emergency System Tools!
Select the desired action to perform in order o repair your damaged system disk.

Click Mext ta continue.

(®Restore system partition from animage:

This action will rebuiid your system as it was when &t was shipaed from the
Factory. You should reinstall your product packs and updates. The image e
is lncated an the unik hard disk or on a USE device.

This action will alow you to select folders and files in order to copy them ta

() Backup data and configuration files to USB Aash drive
USE writable device (bypically a Flash drive).

(O Check disk integrity
This action uses CHKDSK command-ine Uity ko check for the hard disk
integrity and repair it when neede

Note :
Tocalibrate the bouch scrsen, press He Follwing button on the platform:  10=)

fext > Restart
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Troubleshooting

Restoring Your Unit to Normal Operation

5. Select the files to back up.

A check mark indicates a selection of the entire folder (subfolders and
files). A shaded check box indicates that not all of the files of
subfolders are selected.

B Emergency System Tools E‘
Backup data and configuration files to USB flash drive
Select files to copy to the USE Aash drive.,
Click "Next" ko coninue,
Drive: |D: v
Folders:
EXmEo: | a

I Documents and Settings
=) Frogram Fies

[ RECYCLER

I System Yalume Information

6. If the USB device you want to use is not connected to the unit, connect
it now so that the system can find it. Tap Next.
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Troubleshooting

Restoring Your Unit to Normal Operation

7. Select the USB device onto which you want to save the data from the
list of available devices.

% Emergency System Tools

Backup data and configuration files to USB flash drive
Select the UISE flssh drive where your selected files wil be copied, then click"ext" to
stark cpying Files.

usemeda: | EONDMBNDNINN

Space required :  7369.64 MB

Space available : 74.59 MB

Press "Mzt to start copying fles...

Note: Ifyou have forgotten to connect the USB device at this point and that it does
not show up in the list, tap Back, connect the device, then tap Next to
return to this windouw.

8. Tap Next to start the file copy process.

A progress bar indicates which files are being copied. If you tap Cancel
while the transfer is in progress, any file that was copied onto the USB
device will still be on the USB device.

9. Once the transfer is complete, tap Cancel to return to the main
window.
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Troubleshooting

Restoring Your Unit to Normal Operation

To verify disk integrity:
1. Turn on the FTB-1.
2. While the system is displaying the boot menu (3 seconds), press

the down arrow from the unit’s keypad to select the Maintenance and
recovery mode.

OR

Press the ARROW DOWN key on the keyboard (if you have connected
one).

3. Press \/ from the unit’s keypad or ENTER on your keyboard to
confirm your choice.

Note: The touchscreen becomes effective at this point.

4. From the main window, select Check disk integrity, then tap Next.

% Emergency System Tools E‘
Welcome ta Emergency System Tools!
Select the desired action to perform in order ko repair your damaged system disk,
Click Mext to continue.

() Restore system partition from animage:
This action will rebuild your system as it was when it was shipped From the
factary. You should reinstal your product packs and updates. The image file
is located on the unit hard disk or on & USB device,

() Backup data and configuration files to USB Aash drive

This action will alow you to select folders and files in order to copy them ta
USE writable device (typicaly a lash drive),

This action uses CHKDSK command-ine utilly ko check for the hard disk
inkegrity and repair it when neede

(O Check disk integrity )

Note :
Tocalibrate the bouch scrsen, press He Follwing button on the platform:  10=)
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Troubleshooting

Restoring Your Unit to Normal Operation

5. Tap Next to start the disk analysis.

Emergency System Tools E

Check disk integrity
This aperation will scan the entire disk (sl partitions) and repair damaged sectars when

applicable. Click "Next” to start disk analysis.

Disk status:
Partition C: Not checked yet...
Partition D Mot checked yet...

[gpack J[meis ] [ cancel ]

Once the analysis is complete, you can view a report on each drive by
tapping Details.

6. Tap OK once you have finished.

7. To exit the integrity analysis tool, tap Cancel to return to the main
window.
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Troubleshooting
Contacting the Technical Support Group
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Contacting the Technical Support Group

To obtain after-sales service or technical support for this product, contact
EXFO at one of the following numbers. The Technical Support Group is
available to take your calls from Monday to Friday, 8:00 a.m. to 7:00 p.m.
(Eastern Time in North America).

Technical Support Group

400 Godin Avenue 1 866 683-0155 (USA and Canada)
Quebec (Quebec) GIM 2K2 Tel.: 1 418 683-5498
CANADA Fax: 1 418 683-9224

support@exfo.com

For detailed information about technical support, and for a list of other
worldwide locations, visit the EXFO Web site at www.exfo.com.

If you have comments or suggestions about this user documentation, you
can send them to customer.feedback.manual@exfo.com.

To accelerate the process, please have information such as the name and
the serial number (see the product identification label), as well as a
description of your problem, close at hand.

Transportation

Maintain a temperature range within specifications when transporting the
unit. Transportation damage can occur from improper handling. The
following steps are recommended to minimize the possibility of damage:

» Pack the unit in its original packing material when shipping.
» Avoid high humidity or large temperature fluctuations.

» Keep the unit out of direct sunlight.
>

Avoid unnecessary shocks and vibrations.
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13 Warranty

General Information

EXFO Inc. (EXFO) warrants this equipment against defects in material and
workmanship for a period of one year from the date of original shipment.
EXFO also warrants that this equipment will meet applicable specifications
under normal use.

During the warranty period, EXFO will, at its discretion, repair, replace,

or issue credit for any defective product, as well as verify and adjust the
product free of charge should the equipment need to be repaired or if the
original calibration is erroneous. If the equipment is sent back for
verification of calibration during the warranty period and found to meet all
published specifications, EXFO will charge standard calibration fees.

IMPORTANT
The warranty can become null and void if:

» unit has been tampered with, repaired, or worked upon by
unauthorized individuals or non-EXFO personnel.

» warranty sticker has been removed.

» case screws, other than those specified in this guide, have been
removed.

» case has been opened, other than as explained in this guide.
» unit serial number has been altered, erased, or removed.

» unit has been misused, neglected, or damaged by accident.

THIS WARRANTY IS IN LIEU OF ALL OTHER WARRANTIES EXPRESSED,
IMPLIED, OR STATUTORY, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE. IN NO EVENT SHALL EXFO BE LIABLE FOR
SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES.
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Warranty
Liability

Liability
EXFO shall not be liable for damages resulting from the use of the product,
nor shall be responsible for any failure in the performance of other items to

which the product is connected or the operation of any system of which
the product may be a part.

EXFO shall not be liable for damages resulting from improper usage or
unauthorized modification of the product, its accompanying accessories
and software.
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Warranty

Exclusions

Exclusions

EXFO reserves the right to make changes in the design or construction of
any of its products at any time without incurring obligation to make any
changes whatsoever on units purchased. Accessories, including but not
limited to fuses, pilot lamps, batteries and universal interfaces (EUI) used
with EXFO products are not covered by this warranty.

This warranty excludes failure resulting from: improper use or installation,
normal wear and tear, accident, abuse, neglect, fire, water, lightning or
other acts of nature, causes external to the product or other factors beyond
the control of EXFO.

IMPORTANT

In the case of products equipped with optical connectors, EXFO will
charge a fee for replacing connectors that were damaged due to
misuse or bad cleaning.

Certification

EXFO certifies that this equipment met its published specifications at the
time of shipment from the factory.
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Warranty

Service and Repairs

Service and Repairs

EXFO commits to providing product service and repair for five years
following the date of purchase.

To send any equipment for service or repair:

1. Call one of EXFO’s authorized service centers (see EXFO Service
Centers Worldwide on page 215). Support personnel will determine if
the equipment requires service, repair, or calibration.

2. If equipment must be returned to EXFO or an authorized service
center, support personnel will issue a Return Merchandise
Authorization (RMA) number and provide an address for return.

If possible, back up your data before sending the unit for repair.

Pack the equipment in its original shipping material. Be sure to include
a statement or report fully detailing the defect and the conditions under
which it was observed.

5. Return the equipment, prepaid, to the address given to you by support
personnel. Be sure to write the RMA number on the shipping slip. EXFO
will refuse and return any package that does not bear an RMA number.

Note: A test setup fee will apply to any returned unit that, after test, is found to

214

meet the applicable specifications.

After repair, the equipment will be returned with a repair report. If the
equipment is not under warranty, you will be invoiced for the cost
appearing on this report. EXFO will pay return-to-customer shipping costs
for equipment under warranty. Shipping insurance is at your expense.

Routine recalibration is not included in any of the warranty plans. Since
calibrations/verifications are not covered by the basic or extended
warranties, you may elect to purchase FlexCare Calibration/Verification
Packages for a definite period of time. Contact an authorized service center
(see EXFO Service Centers Worldwide on page 215).
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Warranty
EXFO Service Centers Worldwide

EXFO Service Centers Worldwide

If your product requires servicing, contact your nearest authorized service

center.

EXFO Headquarters Service Center
400 Godin Avenue

Quebec (Quebec) GIM 2K2
CANADA

EXFO Europe Service Center
Winchester House, School Lane
Chandlers Ford, Hampshire S053 4DG
ENGLAND

EXFO Telecom Equipment
(Shenzhen) Ltd.

3rd Floor, Building 10,

Yu Sheng Industrial Park (Gu Shu
Crossing), No. 467,

National Highway 107,

Xixiang, Bao An District,
Shenzhen, China, 518126

1 866 683-0155 (USA and Canada)
Tel.: 1 418 683-5498
Fax: 1 418 683-9224
support@exfo.com

Tel.: +44 2380 246800
Fax: +44 2380 246801
support.europe@exfo.com

Tel: +86 (755) 2955 3100
Fax: +86 (755) 2955 3101
support.asia@exfo.com
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A Technical Specifications

IMPORTANT

The following technical specifications can change without notice.
The information presented in this section is provided as a reference
only. To obtain this product’s most recent technical specifications,
visit the EXFO Web site at www.exfo.com.

TECHNICAL SPECIFICATIONS GENERAL SPECIFICATIONS

Display Touchscreen, color, 800 x 480 TFT, 178 mm (7 in) Size (Hx W x D) G0 3 S i G
mx 2oz mmxon !

Interfaces Two USB 2.0 ports (7 1k jin x 8/1%His in x 2% in)

RJ-45 LAN 10/100/1000 Mbit/s ) )

Fiber inspection probe connector port (video) Weight (with battery) 1.5 kg (3.3 Ib)

Builtin Bluetooth and Wi-Fi (hardware option)

Temperature Battery operated: 0 °C to 50 °C (32 °F to 122 °F)

S & € fttrael e ({ish) Operation Charge mode: 5 °C to 40 °C (41 °F to 104 °F)

16 GB internal memory (flash), optional
Batieries Rechargeable lithium-ion batteries Storage unit: ~40 °C 10 70 °C (40 °F to 158 °F)*

! 8 hours of operation as per Telcordia® (Bellcore) TRNWT-001138 unit: =20 °C to 60 °C (-4 °F to 140 °F)
with the battery pack
Power supply  Unit T 24 V; 375 A AC adapter: ~20 °C to 60 °C (-4 °F to 140 °F)
PPY  AG adapter: ~ 100 - 240 V; 50/60 Hz, 1.6 A
Intel ATOM processor
Relative humidit 0 % to 95 % non-cond
_ Computer \yindows Embedded Standard operating system ) Teee ey oo nen-eondensing
ACCESSORIES
FP4S 400x fiber inspection probe GP-2028 Computer security cable kit
FP4D 200x/400x fiber inspection probe GP-2112 3G Universal USB dongle
GP-10-086 Rigid FTB-1 carrying case GP-2113 GPS USB dongle
GP-10-072  Semiigid FTB-1 carrying case GP-2137 USB-to-RS-232 converter
GP-302 USB mouse GP-2138 DC car adapter/inverter
GP-1002 Headset GP-2144 USB 16G micro-drive
GP-1008 VFL adapter (2.5 mm to 1.25 mm) GP-2155 Carry-on size backpack®
GP-2001 USB keyboard GP-2158 FTB-1 utility glove
| GP-2016 10 feet RJ-45 LAN cable GP-2200 Module receptacle back panel
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Technical Specifications

PM-1

Calibrated wavelengths (nm) 850, 1300, 1310, 1490, 1550, 1625, 1650

Optional CWDM calibrated 1270, 1290, 1310, 1330, 1350, 1370, 1390, 1410, 1430, 1450, 1470, 1490,
wavelengths (nm) 1510, 1530, 1550, 1570, 1590, 1610, 1383, 1625

Power range (dBm) 10 to -86 (InGaAs)

26 to -64 (GeX)

Uncertainty (%) * 45 06 £ 3 pW (InGaAs)
£5 9% + 0.4 "W (GeX)

Display resolution (dB)

InGaAs 0.01 =max to —76 dBm
0.1 =-76 dBm to —86 dBm
1=-86 dBm to min

GeX 0.01 = max to =54 dBm
0.1 =-50 dBm to —60 dBm
1=-60 dBm to min

Automatic offset nulling range Max power to =63 dBm for InGaAs
Max power to —40 dBm for GeX

Tone detection (Hz) 270/1000/2000

VISUAL FAULT LOCATOR (VFL) (0PTIONAL)
Laser, 650 nm + 10 nm

Ccw

Typical P, in 62.5/126 pm: 3 dBm (2 mW)

Notes
‘With optional extended-life battery.

. =20 °C to 60 °C (-4 °F to 140 °F) with the battery pack.

The selected model may change without notice.

At 23 °C 1 °C, 1550 nm and FC connector. With modules in idle mode. Battery operated.
Upto 5 dBm.

For +0.05 dB, from 18 °C to 28 °C.

~ 9o a0 oe
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3G USB modem, USiNg .....cceveeriiiurieenneennnn. 106
A
AC requirements .......cccceeeeeeriiiieiee e 16
accessing
Internet with a 3G USB modem........... 106
power meter
adapter .....cccceeveennns
after-sales service .........ccocoeviiiiiiiiiicinnnn, 210
application, starting .........ccccceeviiiiniiieeene 47
B
battery
charge status.......ccccceeeiiiiiiiiiee e 183
ClOCK . 80
maintenance recommendations .......... 183
recharging ......cccoocveveienieenee e 184
replacing or removing ..........cccecveeeenes 188
browsing Web..........occiiiiiiiie 104
C
calibrating the touchscreen...........c.ccce..e. 54
Canadian Standards Association (CSA).......... ix
LoF- ] oI Yo (o -3 14
Capturing iMages .......coovvvveeeeeeeeeiniieeeeeennn 93
car outlet, charging battery with............... 184
caution
of personal hazard..........c..occceeniiinnnnn. 9
of product hazard...........cccoeoeviiniinnnnn. 9
certification information ....
changing batteries .........ccccceeviiiieenennn.
Charger....oooi i
checking data integrity........c.ccccovveniiennnnns 208
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Index

cleaning
detector Ports.......cccceeeeeeeeiiiiiieeeeeeas
front panel........ccooeiiii
touchscreen ..............

connecting to a VPN

ConnectorMax................

conventions, safety........cccococeiiiien e,

coordinates, GPS

creating PDF files

current, electrical...........oouvveeeiiiiiiiiiiieeeeees 16
CUSTOMET SEIVICE ..uvunnieiiiiieeiiie e 214

data
INTEOIILY «ooeviee e
retrieving ......ccocveeeennne
defining personal folders
description, keypad .......c.ccoceeiiiiiiiiiie e,
detecting module
detector port, cleaning.........ccocceevereiienne
documents, printing ........cccceeevviere e,
dongle

E
emergency system tools ...........ccceeviiieene 201
equipment returns.........occcceeeeeiiiiiiieeeenn.
Explorer, Internet............
exporting results.............

external power supply
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Index

F
fiber inspection probe.......c..ccccccvveviinenns 119
file
format ......ooooiiiii
NAME ...
FIP oo
Flash Player, installing
folders, removing .......cccceeecvvveeeiiieeiiiieeens
front panel, cleaning.........cccccecveveiiinnnns
G
GPS coordinates ........cceeeeviieeeiiiieeiniieeene 112
H
hazard, laser radiation.............cccoocveeriinennn. 13
|
identification label .........cccccoiiin 210
image formats........cooeeviiiiini e, 96
INPUL CUITENt ...ooiiiiiiiiiieee e 16
inserting a module ........ccccooiiiiiiiii e 19
inspecting fibers.......ccccooevviiviiere, 119
installing
Flash Player........ccoccoviiiiiiniiiiiiiieceee 102

VPN clients
integrity, data
Internet

CoONNECLION......covviiiieeeeeeeeece e, 106

EXPIOrer ..o 104

keypad description ........ccccevviiiiiiiiiiiine. 6

label, identification ................
laser safety information
localizing your unit.........ccceeiiiiiiiniiieene,
longitude and latitude ...
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maintenance
battery ..o
detector Ports........cceeeeeeeeciiiiieeeeeeins
front panel........ccccoeiiiinnnn
general information
touchscreen ........cccccoveevennee.
maximum input current
modifying storage parameters .................... 96
module
detection .......oooeciiiiieee e 20
INSErtiON...ccciiiii e 19
rEMOVAl ... 19

navigating the Internet........ccccccoooeerineenn. 104

options
SOftWAre. ..o 42
used at startup....ccccoeeeeieeeeeeiiieee, 65
other tools, accessing........ccccvvvveeeriiveennns 116

parameters
for ping...ceeeeciieeieeee
for trace route
PDF files, generating
ping, performing a test ...........ccoceeiiiennen. 175
power
SOUICES ...t eitteeeeireee e et e et eesanee e e e
SUPPIY e
power button
power meter, acCessing.......cccceveeernueeeeeen. 117
predefined folders

PrODE. ..o
product
identification label ..........cccccoooeeinen. 210
specifications ........cccceeeeciiiiiie e, 217
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protective cap .....cccceeeeeieeii
purchased options

radiation hazard, laser
reading Flash files............
removing a module.........ccccoveeiiiiieneninnn.
repairing UNit ........occoeeiiieeiiiiee e
replacing or removing battery.................. 188
restoring system partition ...............ccccee.e 202
retrieving
data ..o
position of unit
return merchandise authorization (RMA) .. 214

S

safety

CAULION .ot 9

CONVENTIONS ...oveiiiiiiie e 9

information

WaAINING ..o
saving test results..........ccoccceiniiiiniinnns 180
screenshots, taking .........ccoccceiiiiii. 93
service and repairs.......cccceeeeeeeeincvieeeeeeeenns 214
service centers
shipping to EXFO ......ccceevviiiiiiiiieiiiceee 214
software

OPLIONS .t

options at startup
software. see application

specifications, product.............ccccveeeeeennn. 217
startup option .......ccccooviiiiiiie 65
storage requirements .........cccccooviiiieeeeeenn. 181
storage, path.......ccccoeiiiiiie 96
surfing the Internet..........ccccoeeevvveiiieeeens 104
symbols, safety........ccccoceviiiiiiniiee e, 9
system

emergency tools ..........ccocerveriiieennn, 201

partition, restoring .........ccccceeeveiieneeen. 202
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NOTICE
BE
CHINESE REGULATION ON RESTRICTION OF HAZARDOUS SUBSTANCES
FEXTRENRRFNAE

NAMES AND CONTENTS OF THE TOXIC OR HAZARDOUS SUBSTANCES OR ELEMENTS
CONTAINED IN THIS EXFO PRODUCT

BEEXEXFOFRANEEREYRARENENANESE

Indicates that this toxic or hazardous substance contained in all of the homogeneous
0 materials for this part is below the limit requirement in SJ/T11363-2006
RTIZEEEEYREZHHFEERM B PSRBT SI/T11363-2006 FrAEMEH
REZERLT,
Indicates that this toxic or hazardous substance contained in at least one of the homogeneous
X materials used for this part is above the limit requirement in SJ/T11363-2006
RTZASEEYREDEZBHNE—GRMBPHEEBE SI/T11363-2006 ¥Rt
AENREER,
Toxic or hazardous Substances and Elements
EEEEYRANTE
Part Name . Hexavalent | Polybrominated | Polybrominated
LR L2 FL Lead Mercury CadTlum Chromium biphenyls diphenyl ethers
“x B At | smmE | sR—xm
(Pb)| (Hg) | (Cd) | (cryp (PBB) (PBDE)
Encl
neeslre o | o 0 0 0 0
HN&
Electronic and
electrical
sub-assembly X o X 0 X X
B ME AL
Optical
sub-assembly? | x 0 0 0 0 0
S
Mechanical
sub-assembly? | 0 0) (o) 0 o)
VA H 2

a. |If applicable.
MREA,




MARKING REQUIREMENTS

FROEER
Product Environmental protection use period (years) Logo
Pl BRERPERBR (F) BRE

This Exfo product 10

AN EXFO 7 f
Battery? .
B8t @
a. If applicable.

MEEA,
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